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Product notice

This user guide describes features that are
common to most models. Some features may
not be available on your computer.

Not all features are available in all editions of
Windows. This computer may require upgraded
and/or separately purchased hardware, drivers
and/or software to take full advantage of
Windows functionality. Go to
http://www.microsoft.com for details.

Software terms

By installing, copying, downloading, or
otherwise using any software product
preinstalled on this computer, you agree to be
bound by the terms of the HP End User License
Agreement (EULA). If you do not accept these
license terms, your sole remedy is to return the
entire unused product (hardware and software)
within 14 days for a full refund subject to the
refund policy of your seller.

For any further information or to request a full
refund of the price of the computer, please
contact your seller.


http://www.microsoft.com

Safety warning notice

A WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not place
the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat surface. Do
not allow another hard surface, such as an adjoining optional printer, or a soft surface, such as pillows or rugs
or clothing, to block airflow. Also, do not allow the AC adapter to contact the skin or a soft surface, such as
pillows or rugs or clothing, during operation. The device and the AC adapter comply with the user-accessible
surface temperature limits defined by the International Standard for Safety of Information Technology
Equipment (IEC 60950-1).
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1  Product features

Standard configuration features

Features may vary depending on the model. For support assistance and to learn more about the hardware
and software installed on your computer model, run the HP Support Assistant utility.

Standard configuration features 1



2

Front panel components

Drive configuration may vary by model. Some models have a bezel blank covering the slim optical drive bay.

Front panel components

1 Slim optical drive (optional) 6 SD card reader (optional)

2 Power button 7 Hard drive activity light

3 USB 2.0 charging (powered) port (black) 8 USB 2.0 port (black)

4 USB 3.0 ports (blue) 9  Audio-out (headphone)/Audio-in (microphone) combo

jack

5 Audio-out (headphone) jack

NOTE: When a device is plugged into the Audio-out (headphone)/Audio-in (microphone) combo jack, a dialog box will pop
up asking if you want to use the jack for a microphone or a headphone. You can reconfigure the jack at any time by double-
clicking the Audio Manager icon in the Windows® taskbar.

NOTE: The USB 2.0 charging port also provides current to charge a device such as a smart phone. The charging current is
available whenever the power cord is plugged into the system, even when the system is off.

NOTE: The Power On light is normally white when the power is on. If it is flashing red, there is a problem with the
computer and it is displaying a diagnostic code. Refer to Interpreting system validation diagnostic front panel LEDs and
audible codes on page 99 to interpret the code.
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Rear panel components

Rear panel components

1 PS/2 keyboard connector (purple) 7 Power cord connector

2 i[®  DisplayPort monitor connectors 8 il PS/2 mouse connector (green)

3 VGA monitor connector 9 Iolola  Serial port

4 o~  USB SuperSpeed ports (blue) 10 2= RJ-45 (network) jack

5 o~ USB SuperSpeed Plus ports (blue)* 11 = USB 2.0 ports (black) with keyboard
wakeup function

6 (¢3»  Audio-out jack for powered audio devices (green) 12 %) Audio-in jack (blue)

NOTE: An optional second serial port and an optional parallel port are available from HP.

If using a USB keyboard, HP recommends connecting the keyboard to one of the USB 2.0 ports with the wakeup feature. The
wakeup feature is also supported on the PS/2 connector if enabled in BIOS F10 Setup.

When a device is plugged into the microphone/headphone jack, a dialog box will pop up asking if you want to use the jack for a
microphone or a headphone. You can reconfigure the jack at any time by double-clicking the Audio Manager icon in the
Windows taskbar.

When a graphics card is installed in one of the system board slots, the video connectors on the graphics card and/or the
integrated graphics on the system board may be used. The specific graphics card installed and software configuration will
determine the behavior.

The system board graphics can be disabled by changing settings in BIOS F10 Setup.
*USB SuperSpeed Plus port

Your product has two USB SuperSpeed Plus ports. This type of port, also called a USB 3.1 Gen 2 port, supports transfer speeds
up to 10 Gbps. For the best performance, follow these guidelines.

e  Useonly USB SuperSpeed Plus-certified cables, 1 meter or less, with USB SuperSpeed Plus—certified devices.

° Periodically inspect the electrical contacts of the cable and device for damage, dirt, or corrosion; replace cables that are
worn or damaged.

° Route the USB SuperSpeed Plus cable away from other cables; do not bundle the cable with other cables.

° Place the device and cable away from other high-powered products or products that may produce high electrical
radiation.

Rear panel components



Serial number location

Each computer has a unique serial number and a product ID number that are located on the exterior of the
computer. Keep these numbers available for use when contacting customer service for assistance.
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2 llustrated parts catalog

Microtower (MT) chassis spare parts

Computer major components

[% NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and then
follow the on-screen instructions.

1]

Item Description
(1) Access panel
(2) Front bezel
3) Power supply

280W, 92% efficient

280W, 85% efficient

280W, standard

(4) System board (includes replacement thermal material)

Microtower (MT) chassis spare parts 5
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Item Description

(5) Fan sink (includes replacement thermal material)

* Memory modules (PC4-17000)

16-GB

8-GB

4-GB

2-GB

X Processors (include replacement thermal material)

AMD A12-9800, 3.8 GHz

AMD A10-9700, 3.5 GHz

AMD A8-9600, 3.5 GHz

AMD A6-9500, 3.1 GHz

AMD A12-8870, 3.7 GHz

AMD A10-8770, 3.5 GHz

AMD A6-8570, 3.5 GHz

x notillustrated
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Misc parts

Item Description

(1 Fan

2 Front I1/0 assembly

(3) Solenoid lock

@) Printer port, PCl card

(5) AMD Radeon R9 350 2GB PCle x16 graphics card
(6) Speaker

7 Secure Digital (SD) card reader

(8) SATA data cable, 18 inch, 1 straight end, 1 angled end
9) SATA drive power cable

X WLAN modules

Microtower (MT) chassis spare parts
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Item Description

Intel Dual Band Wireless-AC 8260 + Bluetooth 4.0

Intel Dual Band Wireless-AC 3165 + Bluetooth 4.0

Intel Dual Band Wireless-AC 7265 NV

* Wireless antenna for use with WLAN modules

* Slim optical drive bezel blank

X Slim optical drive latch

x Hard drive conversion bracket, 2.5-inch to 3.5-inch

X HP Business PC Security Lock

X Center strip kit

x Rubber foot

X Keyed cable lock

X Dual-head keyed cable lock

x Grommet, hard drive isolation, blue, for 3.5-inch hard drives
x Grommet, hard drive isolation, blue, for 2.5-inch hard drives
X DisplayPort cable

X Adapters

DisplayPort to HDMI 1.4

DisplayPort to VGA

DisplayPort to DVI

X DVI display cable

X M.2 USB cable

X Mouse

PS2, optical

USB, laser

USB, optical

Antimicrobial (People’s Republic of China only)

Washable

Wireless (Brazil only)

USB, gray

HP USB Hardened

X Keyboards

USB, gray

PS/2 slim

Antimicrobial
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Item Description

HP USB slim

HP USB Conferencing

Wireless keyboard, mouse, and dongle

USB/PS2 Washable

USB, Smart card

* notillustrated

Misc boards

Description

AMD Radeon R9 350 2GB PCle x16 graphics card

nVIDIA GT730 2 GB DDR3 PClex8

NVIDIA NVS 310 512MB DDR3 PCI Express Gen 2 x16 DisplayPort 1.2 Multi-Display Professional Graphics Board

Intel PRO/1000 NIC

Printer port

Serial port

USB 3.1 Type Cx1 PCle x1 card

PCle to M.2 adapter

WLAN module PCl adapter + Bluetooth

Microtower (MT) chassis spare parts 9
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Drives

Description

Hard drives

2-TB, 7200-rpm

1-TB, 7200-rpm, 3.5-inch

1-TB, hybrid SSD, 5400-rpm, 2.5-inch

1-TB, hybrid SSD, 7200-rpm, 3.5-inch

500 GB, 7200 rpm, 3.5-inch

500-GB, 7200-rpm, 2.5-inch

500-GB, 7200-rpm, 2.5-inch, SED

500-GB, 5400-rpm, 2.5-inch, OPALZ, FIPS

500-GB, 5400-rpm, hybrid SSD, 2.5-inch

Solid-state drives, 2.5-inch

512 GB

512-GB, self-encrypting (SED), OPAL2, TLC

256 GB

256-GB, TLC

256-GB, OPAL2

240-GB, self-encrypting drive (SED), OPAL2, TLC

240-GB, TLC

128 GB

M.2 drives

NOTE: M.2 solid-state drives are installed into an expansion slot using the PCle to M.2 adapter

512-GB, M.2, 2280SS, PCle

512 GB, M.2, NVMe, TLC, PCle

256-GB, M.2, 2280SS, PCle

256-GB, M.2, NVMe, TLC, PCle

Optical drives

DVD+RW drive

DVD-ROM drive

Grommet, hard drive isolation, blue, for 3.5-inch hard drive

Grommet, hard drive isolation, blue, for 2.5-inch hard drive
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3 Routine care, SATA drive guidelines, and
disassembly preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.

A CAUTION: When the computer is plugged into an AC power source, voltage is always applied to the system
board. You must disconnect the power cord from the power source before opening the computer to prevent
system board or component damage.

Electrostatic discharge information

A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic device
exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work perfectly
throughout a normal cycle. The device may function normally for a while, but it has been degraded in the
internal layers, reducing its life expectancy.

Networks built into many integrated circuits provide some protection, but in many cases, the discharge
contains enough power to alter device parameters or melt silicon junctions.

Generating static

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities. A product can be degraded by 700 volts.

e Different activities generate different amounts of static electricity.

e  Static electricity increases as humidity decreases.

Relative Humidity

Event 55% 40% 10%
Walking across carpet 7,500V 15,000V 35,000V
Walking across vinyl floor 3,000V 5,000V 12,000V
Motions of bench worker 400V 800V 6,000V
Removing DIPs from plastic tube 400V 700V 2,000V
Removing DIPs from vinyl tray 2,000V 4,000V 11,500V
Removing DIPs from Styrofoam 3,500V 5,000V 14,500V
Removing bubble pack from PCB 7,000V 20,000V 26,500V
Packing PCBs in foam-lined box 5,000V 11,000V 21,000V

Electrostatic discharge information
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Preventing electrostatic damage to equipment

Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree of
sensitivity. The following packaging and grounding precautions are necessary to prevent damage to electric
components and accessories.

To avoid hand contact, transport products in static-safe containers such as tubes, bags, or boxes.

Protect all electrostatic-sensitive parts and assemblies with conductive or approved containers or
packaging.

Keep electrostatic-sensitive parts in their containers until they arrive at static-free stations.
Place items on a grounded surface before removing them from their containers.

Always be properly grounded when touching a sensitive component or assembly.

Avoid contact with pins, leads, or circuitry.

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive
foam.

Personal grounding methods and equipment

Use the following equipment to prevent static electricity damage to equipment:

Wrist straps are flexible straps with a maximum of one-megohm * 10% resistance in the ground cords.
To provide proper ground, a strap must be worn snugly against bare skin. The ground cord must be
connected to the banana plug connector on the grounding mat or workstation and fit snugly into it.

Heel straps/Toe straps/Boot straps can be used at standing workstations and are compatible with
most types of shoes or boots. On conductive floors or dissipative floor mats, use them on both feet with
a maximum of one-megohm + 10% resistance between the operator and ground.

Static Shielding Protection Levels

Method Voltage
Antistatic plastic 1,500
Carbon-loaded plastic 7,500
Metallized laminate 15,000

Grounding the work area

To prevent static damage at the work area, observe the following precautions:

Cover the work surface with approved static-dissipative material. Provide a wrist strap connected to the
work surface and use properly grounded tools and equipment.

Use static-dissipative mats, foot straps, or air ionizers to give added protection.

Handle electrostatic-sensitive components, parts, and assemblies by the case or PCB laminate. Handle
them only at static-free work areas.

Turn off power and input signals before inserting and removing connectors or test equipment.
Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.
Keep work area free of nonconductive materials such as ordinary plastic assembly aids and Styrofoam.

Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.
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Recommended materials and equipment

The following grounding equipment is recommended to prevent electrostatic damage:

Antistatic tape

Antistatic smocks, aprons, or sleeve protectors

Conductive bins and other assembly or soldering aids

Conductive foam

Conductive tabletop workstations with ground cords of one-megohm +/- 10% resistance
Static-dissipative table or floor mats with hard ties to ground

Field service kits

Static awareness labels

Wrist straps and footwear straps providing one-megohm +/- 10% resistance
Material handling packages

Conductive plastic bags

Conductive plastic tubes

Conductive tote boxes

Opaque shielding bags

Transparent metallized shielding bags

Transparent shielding tubes

Operating guidelines

To prevent overheating and to help prolong the life of the computer:

Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and cold.

Operate the computer on a sturdy, level surface. Leave a 10.2 cm (4-inch) clearance on all vented sides
of the computer and above the monitor to permit the required airflow.

Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign matter
can block the vents and limit the airflow. Be sure to unplug the computer before cleaning the air vents.

Never operate the computer with the cover or side panel removed.

Do not stack computers on top of each other or place computers so near each other that they are subject
to each other’s re-circulated or preheated air.

If the computer is to be operated within a separate enclosure, intake and exhaust ventilation must be
provided on the enclosure, and the same operating guidelines listed above will still apply.

Keep liquids away from the computer and keyboard.

Operating guidelines 13
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e  Never cover the ventilation slots on the monitor with any type of material.

e |Install or enable power management functions of the operating system or other software, including
sleep states.

Routine care

General cleaning safety precautions

1. Never use solvents or flammable solutions to clean the computer.

2. Neverimmerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and then use
the cloth on the component.

3.  Always unplug the computer when cleaning with liquids or damp cloths.

4.  Always unplug the computer before cleaning the keyboard, mouse, or air vents.
5. Disconnect the keyboard before cleaning it.
6

Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the computer case

Follow all safety precautions in General cleaning safety precautions on page 14 before cleaning the computer.

To clean the computer case, follow the procedures described below:
e  Toremove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

e  For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping the surface
with a cloth or swab dampened with clear water.

e  For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed; alcohol will evaporate quickly
without leaving a residue.

e  After cleaning, always wipe the unit with a clean, lint-free cloth.

e  Occasionally clean the air vents on the computer. Lint and other foreign matter can block the vents and
limit the airflow.

Cleaning the keyboard

Follow all safety precautions in General cleaning safety precautions on page 14 before cleaning the keyboard.

To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the computer
case on page 14.

When cleaning debris from under the keys, review all rules in General cleaning safety precautions on page 14
before following these procedures:

A CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from under the
keys.

e  Visible debris underneath or between the keys may be removed by vacuuming or shaking.

e  (Canned, pressurized air may be used to clean debris from under the keys. Caution should be used as too
much air pressure can dislodge lubricants applied under the wide keys.
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e |f youwant to remove a key, use a specially designed key puller to prevent damage to the keys. This tool
is available through many electronics supply outlets.

A CAUTION: Never remove a wide, level key (like the space bar) from the keyboard. If these keys are
improperly removed or installed, the keyboard may not function properly.

e  (leaning under a key may be done with a swab moistened with isopropyl alcohol and then squeezed out.
Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers to remove any
fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the monitor

e  Wipe the monitor screen with a towelette designed for cleaning monitors or with a clean cloth
moistened with water. Do not use sprays or aerosols directly on the screen; the liquid may seep into the
housing and damage a component. Never use solvents or flammable liquids on the monitor.

e  To clean the monitor body follow the procedures in Cleaning the computer case on page 14.

Cleaning the mouse

Before cleaning the mouse, ensure that the power to the computer is turned off.

e  (lean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out any
debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

e To clean the mouse body, follow the procedures in Cleaning the computer case on page 14.

Service considerations

Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Tools and software requirements

To service the computer, you need the following:

e  Torx T-15 screwdriver

e  Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)
e  Phillips #2 screwdriver

° Diagnostics software

Screws

The screws used in the computer are not interchangeable. They may have standard or metric threads and may
be of different lengths. If an incorrect screw is used during the reassembly process, it can damage the unit. HP
strongly recommends that all screws removed during disassembly be kept with the part that was removed,
then returned to their proper locations.

A CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard drives only.

CAUTION: As each subassembly is removed from the computer, it should be placed away from the work area
to prevent damage.
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Cables and connectors

Most cables used throughout the unit are flat, flexible cables. These cables must be handled with care to
avoid damage. Apply only the tension required to seat or unseat the cables during insertion or removal from
the connector. Handle cables by the connector whenever possible. In all cases, avoid bending or twisting the
cables, and ensure that the cables are routed in such a way that they cannot be caught or snagged by parts
being removed or replaced.

A CAUTION: When servicing this computer, ensure that cables are placed in their proper location during the
reassembly process. Improper cable placement can damage the computer.

Hard Drives

Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This applies
to failed drives as well as replacement spares.

e [f adrive must be mailed, place the drive in a bubble-pack mailer or other suitable protective packaging
and label the package “Fragile: Handle With Care.”

e Do not remove hard drives from the shipping package for storage. Keep hard drives in their protective
packaging until they are actually mounted in the computer.

e  Avoid dropping drives from any height onto any surface.

e If youare inserting or removing a hard drive, turn off the computer. Do not remove a hard drive while the
computer is on or in standby mode.

e  Before handling a drive, ensure that you are discharged of static electricity. While handling a drive, avoid
touching the connector.

e Do not use excessive force when inserting a drive.
e  Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields

such as monitors or speakers.

Lithium coin cell battery

The battery that comes with the computer provides power to the real-time clock and has a minimum lifetime
of about three years.

See the appropriate removal and replacement chapter for the chassis you are working on in this guide for
instructions on the replacement procedures.

A WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the battery is
handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in water or fire, or
expose it to temperatures higher than 140°F (602C). Do not attempt to recharge the battery.

294

[5f NOTE: Batteries, battery packs, and accumulators should not be disposed of together with general
household waste. In order to forward them for recycling or proper disposal, please use the public collection
system or return them to HP.
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SATA hard drives

Serial ATA Hard Drive Characteristics

Number of pins/conductors in data cable

7/7

Number of pins in power cable

15

Maximum data cable length

39.37in (100 cm)

Data interface voltage differential 400-700 mV
Drive voltages 3.3V,5V,12V
Jumpers for configuring drive N/A

Data transfer rate 6.0 Gb/s

SMART ATA drives

The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for HP personal computers have
built-in drive failure prediction that warns the user or network administrator of an impending failure (crash)

of the hard drive. The SMART drive tracks fault prediction and failure indication parameters such as

reallocated sector count, spin retry count, and calibration retry count. If the drive determines that a failure is

imminent, it generates a fault alert.

SATA hard drives
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4 Removal and replacement procedures -
Microtower (MT) chassis

Adherence to the procedures and precautions described in this chapter is essential for proper service. After
completing all necessary removal and replacement procedures, run the Diagnostics utility to verify that all
components operate properly.

[%r NOTE: Not all features listed in this guide are available on all computers.

r_'%" NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and then
follow the on-screen instructions.

Preparation for disassembly

See Routine care, SATA drive guidelines, and disassembly preparation on page 11 for initial safety procedures.

1.

2
3.
4
5

6.
7.

Remove/disengage any security devices that prohibit opening the computer.
Close any open software applications.

Exit the operating system.

Remove any compact disc or media card from the computer.

Turn off the computer and any peripheral devices that are connected to it.

A CAUTION: Turn off the computer before disconnecting any cables.

Regardless of the power-on state, voltage is always present on the system board as long as the system
is plugged into an active AC outlet. In some systems the cooling fan is on even when the computer is in
the “Standby,” or “Suspend” modes. The power cord should always be disconnected before servicing a
unit.

Disconnect the power cord from the electrical outlet and then from the computer.

As applicable, lay the computer down on its side to achieve a safe working position.

[%’ NOTE: During disassembly, label each cable as you remove it, noting its position and routing. Keep all

screws with the units removed.

A CAUTION: The screws used in the computer are of different thread sizes and lengths; using the wrong screw
in an application may damage the unit.
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Access panel

To access internal components, you must remove the access panel:

1.  Prepare the computer for disassembly (Preparation for disassembly on page 18)

2. Pull up the access panel handle (1), and then slide the panel back (2) and lift it off the computer (3).

To replace the access panel, reverse the disassembly procedures.
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Front bezel

1.  Prepare the computer for disassembly (Preparation for disassembly on page 18)

2. Remove the access panel (Access panel on page 19)

3.  Lift up the three tabs on the side of the bezel (1), and then rotate the bezel off the chassis (2).

To replace the front bezel, reverse the disassembly procedures.
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Front bezel security

The front bezel can be secured in place by installing a screw through the front of the chassis into the front
bezel.

1.  Prepare the computer for disassembly (Preparation for disassembly on page 18)

2. Remove the access panel (Access panel on page 19)

3. Install a 6-32 screw through the front of the chassis and into the screw hole located below the center
bezel release tab.

4. Replace the computer access panel.
5. Reconnect the power cord and any external devices, and then turn on the computer.

6. Lock any security devices that were disengaged when the access panel was removed.
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Slim optical drive bezel blank

On some models, there is a bezel blank covering the slim optical drive bay. Remove the bezel blank before
installing an optical drive. To remove the bezel blank:

1. Remove the access panel (Access panel on page 19)

2. Remove the front bezel (Front bezel on page 20)

3. Toremove the bezel blank, press upward on the bottom tab and press downward on the top tab on the
side of the blank (1), and then rotate the blank off the front of the bezel (2).
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Memory

DIMMs

Description

16-GB, PC4-17000

8-GB, PC4-17000

4-GB, PC4-17000

2-GB, PC4-17000

The computer comes with double data rate 4 synchronous dynamic random access memory (DDR4-SDRAM)
dual inline memory modules (DIMMs).

The memory sockets on the system board can be populated with up to four industry-standard DIMMs. These
memory sockets are populated with at least one preinstalled DIMM. To achieve the maximum memory
support, you can populate the system board with up to 64 GB of memory configured in a high-performing
dual channel mode.

DDR4-SDRAM DIMMs

For proper system operation, the DIMMs must be:

e  industry-standard 288-pin

e unbuffered non-ECC PC4-17000 DDR4-2133 MHz-compliant
e  1.2volt DDR4-SDRAM DIMMs

The DIMMs must also:

e  support CAS latency 15 DDR4 2133 MHz (15-15-15 timing)
e  contain the mandatory JEDEC SPD information

In addition, the computer supports:

e  512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies
e  single-sided and double-sided DIMMs

° DIMMs constructed with x8 and x16 DDR devices; DIMMs constructed with x4 SDRAM are not supported

[%”f NOTE: The system will not operate properly if you install unsupported DIMMs.

Populating DIMM sockets

There are four DIMM sockets on the system board, with two sockets per channel. The sockets are labeled
DIMM1, DIMMZ2, DIMM3, and DIMM4. Sockets DIMM1 and DIMMZ2 operate in memory channel B. Sockets DIMM3
and DIMM4 operate in memory channel A.

The system will automatically operate in single channel mode, dual channel mode, or flex mode, depending
on how the DIMMs are installed.

[% NOTE: Single channel and unbalanced dual channel memory configurations will result in inferior graphics

performance.

Memory
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e  The system will operate in single channel mode if the DIMM sockets are populated in one channel only.

e  The system will operate in a higher-performing dual channel mode if the total memory capacity of the
DIMMs in Channel A is equal to the total memory capacity of the DIMMs in Channel B. The technology and
device width can vary between the channels. For example, if Channel A is populated with two 1 GB
DIMMs and Channel B is populated with one 2 GB DIMM, the system will operate in dual channel mode.

e  The system will operate in flex mode if the total memory capacity of the DIMMs in Channel A is not equal
to the total memory capacity of the DIMMs in Channel B. In flex mode, the channel populated with the
least amount of memory describes the total amount of memory assigned to dual channel and the
remainder is assigned to single channel. For optimal speed, the channels should be balanced so that the
largest amount of memory is spread between the two channels. If one channel will have more memory
than the other, the larger amount should be assigned to Channel A. For example, if you are populating
the sockets with one 2 GB DIMM, and three 1 GB DIMMs, Channel A should be populated with the 2 GB
DIMM and one 1 GB DIMM, and Channel B should be populated with the other two 1 GB DIMMs. With this
configuration, 4 GB will run as dual channel and 1 GB will run as single channel.

e Inany mode, the maximum operational speed is determined by the slowest DIMM in the system.

Installing DIMMs

A CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power to drain

before adding or removing memory modules. Regardless of the power-on state, voltage is always supplied to
the memory modules as long as the computer is plugged into an active AC outlet. Adding or removing
memory modules while voltage is present may cause irreparable damage to the memory modules or system
board.

The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is important
to use memory modules with gold-plated metal contacts to prevent corrosion and/or oxidation resulting from
having incompatible metals in contact with each other.

Static electricity can damage the electronic components of the computer or optional cards. Before beginning
these procedures, ensure that you are discharged of static electricity by briefly touching a grounded metal
object.

When handling a memory module, be careful not to touch any of the contacts. Doing so may damage the
module.

1. Prepare the computer for disassembly (Preparation for disassembly on page 18)

2. Remove the access panel (Access panel on page 19)
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3. Open both latches of the memory module socket (1), and insert the memory module into the socket (2).

o

-
@

99

= NOTE: A memory module can be installed in only one way. Match the notch on the module with the tab
on the memory socket.

Populate the black DIMM sockets before the white DIMM sockets.

For maximum performance, populate the sockets so that the memory capacity is spread as equally as
possible between Channel A and Channel B.

4. Push the module down into the socket, ensuring that the module is fully inserted and properly seated.
Make sure the latches are in the closed position (3).

Repeat steps 3 and 4 to install any additional modules.
Replace the computer access panel.

Reconnect the power cord and turn on the computer.

S

Lock any security devices that were disengaged when the access panel was removed.

The computer should automatically recognize the additional memory the next time you turn on the computer.
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Expansion cards

Description

AMD Radeon R9 350 2GB PCle x16 graphics card

nVIDIA GT730 2 GB DDR3 PClex8

NVIDIA NVS 310 512MB DDR3 PCI Express Gen 2 x16 DisplayPort 1.2 Multi-Display Professional Graphics Board

USB 3.1 Type Cx1 PCle x1 card

Printer port, PCl card

Serial port, PCl card

PCle to M.2 adapter

Intel PRO/1000 NIC

Intel Dual Band Wireless-AC 8260 + Bluetooth 4.0

Intel Dual Band Wireless-AC 3165 + Bluetooth 4.0

Intel Dual Band Wireless-AC 7265 NV

WLAN module PCl adapter + Bluetooth

M.2 USB cable

Wireless antenna for use with WLAN modules

The computer has two PCl Express x1 expansion sockets, one PCl Express x16 expansion socket, and one PCI
Express x16 expansion socket that is downshifted to a x4 socket.

[%'/]’9 NOTE: You caninstall a PCl Express x1, x8, or x16 expansion card in the PCl Express x16 socket.

For dual graphics card configurations, the first (primary) card must be installed in the PCl Express x16 socket
that is NOT downshifted to a x4.

To remove, replace, or add an expansion card:

1.  Prepare the computer for disassembly (Preparation for disassembly on page 18)

2. Remove the access panel (Access panel on page 19)

26 Chapter 4 Removal and replacement procedures — Microtower (MT) chassis



3. Release the slot cover retention latch that secures the slot covers by lifting the tab on the latch and
rotating the latch to the open position.

)

4. Locate the correct vacant expansion socket on the system board and the corresponding expansion slot
on the back of the computer chassis.

5. Before installing an expansion card, remove the expansion slot cover or the existing expansion card.

@ NOTE: Before removing an installed expansion card, disconnect any cables that may be attached to
the expansion card.

a. Ifyou areinstalling an expansion card in a vacant socket, you must slide one of the expansion slot
covers up and out of the chassis or use a flat-bladed screwdriver to pry out one of the metal
shields on the rear panel that covers the expansion slot. Be sure to remove the appropriate shield

for the expansion card you are installing.
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b. If youare removing a PCl Express x1 card, hold the card at each end and carefully rock it back and
forth until the connectors pull free from the socket. Lift the card straight up (1) then away from the
inside of the chassis (2) to remove it. Be sure not to scrape the card against other components.

¢. Ifyouare removing a PCl Express x16 card, pull the retention arm on the back of the expansion
socket away from the card and carefully rock the card back and forth until the connectors pull free
from the socket. Lift the card straight up then away from the inside of the chassis to remove it. Be
sure not to scrape the card against other components.

6. Store the removed card in anti-static packaging.

7. Ifyou are not installing a new expansion card, install an expansion slot cover to close the open slot.

A CAUTION: After removing an expansion card, you must replace it with a new card or expansion slot
cover for proper cooling of internal components during operation.
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To install a new expansion card, hold the card just above the expansion socket on the system board then
move the card toward the rear of the chassis (1) so that the bottom of the bracket on the card slides into
the small slot on the chassis. Press the card straight down into the expansion socket on the system
board (2).

@7 NOTE: When installing an expansion card, press firmly on the card so that the whole connector seats

9.

10.

11.
12.
13.
14.

properly in the expansion card socket.

Rotate the slot cover retention latch back in place to secure the expansion card.

Connect external cables to the installed card, if needed. Connect internal cables to the system board, if
needed.

Replace the computer access panel.
Reconnect the power cord and turn on the computer.
Lock any security devices that were disengaged when the computer access panel was removed.

Reconfigure the computer, if necessary.
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Drives

Description

Hard drives

2-TB, 7200-rpm

1-TB, 7200-rpm, 3.5-inch

1-TB, hybrid SSD, 5400-rpm, 2.5-inch

1-TB, hybrid SSD, 7200-rpm, 3.5-inch

500 GB, 7200 rpm, 3.5-inch

500-GB, 7200-rpm, 2.5-inch

500-GB, 7200-rpm, 2.5-inch, SED

500-GB, 5400-rpm, 2.5-inch, OPAL2, FIPS

500-GB, 5400-rpm, hybrid SSD, 2.5-inch

Solid-state drives, 2.5-inch

512 GB

512-GB, self-encrypting (SED), OPAL2, TLC

256 GB

256-GB, TLC

256-GB, OPAL2

240-GB, self-encrypting drive (SED), OPAL2, TLC

240-GB, TLC

128 GB

M.2 drives

NOTE: M.2 solid-state drives are installed into an expansion slot using the PCle to M.2 adapter

512-GB, M.2, 2280SS, PCle

512 GB, M.2, NVMe, TLC, PCle

256-GB, M.2, 2280SS, PCle

256-GB, M.2, NVMe, TLC, PCle

Optical drives

DVD+RW drive

DVD-ROM drive

Grommet, hard drive isolation, blue, for 3.5-inch hard drive

Grommet, hard drive isolation, blue, for 2.5-inch hard drive

When installing drives, follow these guidelines:
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e  The primary Serial ATA (SATA) hard drive must be connected to the dark blue primary SATA connector on
the system board labeled SATAO.

e  (Connect secondary hard drives and optical drives to one of the light blue SATA connectors on the system
board (labeled SATA1 and SATA2).

e  HP has provided four extra 6-32 hard drive mounting screws installed on the front of the chassis next to
the hard drive bays (1). If you are replacing a hard drive, remove the mounting screws from the old drive
and install them in the new drive.

li_)f’ IMPORTANT: To prevent loss of work and damage to the computer or drive:

If you are inserting or removing a drive, shut down the operating system properly, turn off the computer, and
unplug the power cord. Do not remove a drive while the computer is on or in standby mode.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive, avoid
touching the connector. For more information about preventing electrostatic damage, refer to Electrostatic
discharge information on page 11.

Handle a drive carefully; do not drop it.
Do not use excessive force when inserting a drive.

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic fields such as
monitors or speakers.

If a drive must be mailed, place the drive in a bubble-pack mailer or other protective packaging and label the
package “Fragile: Handle With Care.”
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Drive positions

Drive positions

1

9.5 mm slim optical drive bay

2

3.5-inch secondary hard drive bay

3

3.5-inch primary hard drive bay

NOTE: The drive configuration on your computer may be different than the drive configuration shown above.

To verify the type and size of the storage devices installed in the computer, run Computer Setup.

Removing a 9.5 mm slim optical drive

1.

2
3.
q

Prepare the computer for disassembly (Preparation for disassembly on page 18)

Remove the access panel (Access panel on page 19)

Remove the front bezel (Front bezel on page 20)

Disconnect the power cable and data cable from the back of the optical drive.

A CAUTION: When removing the cables, pull the tab or connector instead of the cable itself to avoid
damaging the cable.

Chapter 4 Removal and replacement procedures — Microtower (MT) chassis



5. Disconnect the power cable (1) and data cable (2) from the rear of the optical drive.

A CAUTION: When removing the cables, pull the tab or connector instead of the cable itself to avoid
damaging the cable.

6. Press upward on the green release latch on the underside of the drive (1), and then slide the drive out of
the drive bay (2).
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33



Installing a 9.5 mm slim optical drive

1. Prepare the computer for disassembly (Preparation for disassembly on page 18).

2. Remove the access panel (Access panel on page 19).

3. Ifyou areinstalling a slim optical drive in a bay covered by a bezel blank, remove the front bezel and
then remove the bezel blank. See Front bezel on page 20 for more information.

4. Follow the instructions for removing the optical drive if one was installed. Refer to Removing a 9.5 mm
slim optical drive on page 32.

5.  Align the small pin on the release latch with the small hole on the side of the drive and press the latch
firmly onto the drive.

6. Slide the optical drive through the front of the chassis (1) all the way into the bay so that the green latch
locks onto the chassis frame (2).
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7.

10.
11.
12.

Connect the power cable (1) and data cable (2) to the rear of the optical drive.

If installing a new drive, connect the opposite end of the data cable to one of the light blue SATA
connectors (labeled SATA1 or SATA2) on the system board.

Replace the front bezel if it was removed.
Replace the computer access panel.
Reconnect the power cord and any external devices, and then turn on the computer.

Lock any security devices that were disengaged when the access panel was removed.
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Removing a hard drive

@9 NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so that you
can transfer the data to the new hard drive.

1.  Prepare the computer for disassembly (Preparation for disassembly on page 18).

2. Remove the access panel (Access panel on page 19).

3. Disconnect the data cable (1) and power cable (2) from the rear of the hard drive.

4. Pull the green latch next to the drive outward (1) and slide the drive out of the bay (2).
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Installing a hard drive

1.  Prepare the computer for disassembly (Preparation for disassembly on page 18).

2. Remove the access panel (Access panel on page 19).

3. Youcaninstall a 3.5-inch hard drive or a 2.5-inch hard drive with a 3.5-inch adapter bracket similar to
the example shown below.

e  Slide the 2.5-inch drive into the bay adapter bracket, ensuring the connector on the drive is fully
inserted into the connector on the adapter bracket.

e  Secure the drive to the bay adapter bracket by installing four black M3 adapter bracket screws
through the sides of the bracket into the drive.
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4. Install four mounting screws into the sides of the 3.5-inch drive or the 2.5-inch drive adapter bracket
(two on each side).

I? NOTE: HP has supplied four extra mounting screws installed on the chassis next to the hard drive bays.
Refer to Drives on page 30 for an illustration of the location of the extra mounting screws.

5. Slide the drive into the drive bay, making sure to align the mounting screws with the guide slots, until
the drive snaps into place.
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6.

1.

949

= NOTE: Youmust connect the primary hard drive data cable to the dark blue connector labeled SATAO to

10.

Connect the data cable (1) and power cable (2) to the rear of the hard drive.

If installing a new drive, connect the opposite end of the data cable to the appropriate system board
connector.

avoid any hard drive performance problems. If you are adding a second hard drive, connect the data
cable to one of the light blue SATA connector labeled SATAT and SATA2.

Replace the computer access panel.
Reconnect the power cord and any external devices, and then turn on the computer.

Lock any security devices that were disengaged when the access panel was removed.
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Drive power cable

1.

2
3
4.
5

Prepare the computer for disassembly (Preparation for disassembly on page 18).

Remove the computer access panel (Access panel on page 19).

Remove the cable from the clips on the base pan and on the side of the hard drive cage (1).

Disconnect the cable from the hard drive (2) and the optical drive (3)

Disconnect the cable from the system board connector labeled SATAPWRO (4), and then remove the
cable from the computer.

To reinstall the drive power cable, reverse the removal procedure.
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Front 1/0 and power switch assembly

1.  Prepare the computer for disassembly (Preparation for disassembly on page 18).

Remove the access panel (Access panel on page 19).

2
3. Remove the front bezel (Front bezel on page 20).
4

Remove the Torx T15 screw (1) that secures the assembly to the chassis, push the tab on the right side
of the assembly (2) to disengage it from the chassis, and then push the assembly into the chassis (3).

5. Remove the cables from the clips on the base pan.
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6. Disconnect the four cables from the following system board connectors:
(1) Front USB (blue)
(2) Front AUD (yellow)
(3) Front USB3.1 (blue)
(4) PB/LED (black)

7. Remove the front I/0 and power switch assembly from the inside of the computer.

To reinstall the assembly, reverse the removal procedure.
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Fan sink

A CAUTION: The bond between the fan sink and the processor may be very tight.

If the computer will power on, before removing the fan sink, turn on the computer until it warms the fan sink.
Warming the fan sink lessens the bond between the heat sink and the processor, thereby making separating
them easier.

Make sure not to pull the processor out of the socket when you lift the fan sink, especially if you cannot warm
the fan sink prior to removal. Inadvertently removing the processor can damage the pins.

1.  Prepare the computer for disassembly (Preparation for disassembly on page 18).

Remove the access panel (Access panel on page 19).

2
3. Disconnect the fan cable from the system board connector labeled CPUFAN (1).
4

Loosen the four silver captive Torx T15 screws (2) that secure the fan sink to the system board.

A CAUTION: Remove fan sink retaining screws in diagonally opposite pairs (as in an X) to even the
downward forces on the processor. The pins on the socket are very fragile and any damage to them may
require replacing the system board.

5.  Lift the heat sink from atop the processor (3).

When reinstalling the fan sink, make sure that its bottom has been cleaned with an alcohol wipe and fresh
thermal grease has been applied to the top of the processor.

A CAUTION: Fan sink retaining screws should be tightened in diagonally opposite pairs (as in an X) to evenly
seat the fan sink on the processor. This is especially important as the pins on the socket are very fragile and
any damage to them may require replacing the system board.
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Processor

Description

AMD A12-9800, 3.8 GHz

AMD A10-9700, 3.5 GHz

AMD A8-9600, 3.5 GHz

AMD A6-9500, 3.1 GHz

AMD A12-8870, 3.7 GHz

AMD A10-8770, 3.5 GHz

AMD A6-8570, 3.5 GHz

1.  Prepare the computer for disassembly (Preparation for disassembly on page 18).

Remove the access panel (Access panel on page 19).

Remove the fan sink (Fan sink on page 43).

Rotate the locking lever to its full open position (1).

i & wonN

Carefully lift the processor from the socket (2).

A CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and handling
them could cause irreparable damage. Once pins are damaged it may be necessary to replace the
system board.

The heat sink must be installed within 24 hours of installing the processor to prevent damage to the
processor’s solder connections.

Reverse the removal procedure to install a new processor.
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[% NOTE: Afterinstalling a new processor onto the system board, update the system ROM to ensure that the

latest version of the BIOS is being used on the computer. The latest system BIOS can be found on the Web at:

http://h18000.www1.hp.com/support/files.

Speaker

1.  Prepare the computer for disassembly (Preparation for disassembly on page 18).

2. Remove the access panel (Access panel on page 19).

3. Disconnect the speaker wire from the system board connector labeled SPKR (1), and then remove the
wire from the clip.

4. From the inside of the chassis, remove the silver Torx T15 screw (2) that secures the speaker to the
chassis.

5. Remove the speaker from the chassis (3).

To replace the speaker, reverse the removal procedures.

Speaker
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Rear chassis fan

1.  Prepare the computer for disassembly (Preparation for disassembly on page 18).

2. Remove the access panel (Access panel on page 19).

3. Remove the three silver Phillips screws that secure the fan to the rear of chassis.

4. Disconnect the fan control cable (1) from the system board connector labeled PSFAN.

5.  Lift the fan out of the chassis (2).

To install the fan assembly, reverse the removal procedure. Be sure to orient the air flow out of the unit.
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Power supply

Description

Power supply, 280W, 92% efficient

Power supply, 280W, 85% efficient

Power supply, 280W, standard

1.  Prepare the computer for disassembly (Preparation for disassembly on page 18).

2. Remove the access panel (Access panel on page 19).

3. Remove the four silver Torx T15 screws that connect the power supply to the rear of the chassis.

4. Remove the power cable from the clip on the base pan.
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5. Disconnect the power supply cable from the following system board connectors:
(1) PWR
(2) PWRCMD
(3) PWRCPU

6. Pressthe tab (1) on the base pan in front of the power supply that holds it in place.

7. Slide the power supply toward the front of the computer (2), rotate toward the fan so the power supply
clears the lip on the top of the chassis, and then lift the power supply out of the chassis (3).

To install the power supply, reverse the removal procedure.
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System board

1.
2.
3.

Prepare the computer for disassembly (Preparation for disassembly on page 18).

Remove the access panel (Access panel on page 19).

When replacing the system board, make sure the following components are removed from the defective
system board and installed on the replacement system board:

Memory modules (Memory on page 23)

Expansion cards (Expansion cards on page 26)

Heat sink (Fan sink on page 43).

Processor (Processor on page 44)

Disconnect all cables connected to the system board, noting their location for reinstallation.

Remove the eight Torx T15 screws (1) that secure the system board to the chassis.

Slide the system board away from the connectors (2), and then lift it up and out of the computer (3).

When reinstalling the system board, first insert the I/0 panel back into the slots in the rear of the chassis, and
then align the board with the chassis screw holes.

[%? NOTE: When replacing the system board, you must change the chassis serial number in the BIOS.

System board
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System board callouts

PS
FAN HLOCK HSENSE

L

X4PCl  X1PCI X16PCI  X1PCI
EXP EXP2 EXP EXP1

] 'i-“:

FRONT o ez Ay
AUD g 7 . i |- 28
. N , —— PWRCPU
USB2 == :
R — SATA2
201 _wt 4 FRONT
: A UsSB3
SD RDR
— XU1
|m '
- —————
USB_G == ; SATAD
- CPUFAN
. Lal
@ \TF SATA1
cMos '
¥ = DIMM4
PSWD = DIMM4
= DIMM4
= DIMM4
COMB XBT  SPKR va\.rR SATA  pywreMD | D
Sys Bd Label color Component Sys Bd Label color Component
X4PCIEXP White Expansion card DIMM3 Black Memory module
X1PCIEXP2 Black Expansion card DIMM2 White Memory module
X16PCIEXP Black Expansion card DIMM1 Black Memory module
X1PCIEXP1 Black Expansion card PB/LED Black Front 1/0/power switch
PSFAN Red Chassis fan PWRCMD White Power supply
HLCK Black Hood lock SATA PWRO Black Drive power
HSENSE White Hood sensor PWR White 6-pin main power
PWRCPU White 4-pin processor power SPKR White Speaker
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Sys Bd Label color Component Sys Bd Label color Component
SATA2 Light blue  Any SATA Device other XBT Black RTC battery
than the primary hard
drive
FRONT USB3 Blue Front 1/0 and power COMB Black Optional second serial
switch port
SD RDR Black Card reader PSWD Green Clear system passwords
XU Black Processor CMOS Yellow Reset CMOS
SATAO Dark blue  Hard drive USB C White USB C connector
CPUFAN White Processor fan USB2 Yellow Front1/0
SATA1 Light blue  Any SATA Device other FRONT AUD Blue Front 1/0
than the primary hard
drive
DIMM4 White Memory module

System board
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5 Computer Setup (F10) Utility

Computer Setup (F10) Utilities

Use Computer Setup (F10) Utility to do the following:

Change factory default settings.

View the system configuration, including settings for processor, graphics, memory, audio, storage,
communications, and input devices.

Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash media devices.

Select Post Messages Enabled or Disabled to change the display status of Power-0n Self-Test (POST)
messages. Post Messages Disabled suppresses most POST messages, such as memory count, product
name, and other non-error text messages. If a POST error occurs, the error is displayed regardless of the
mode selected. To manually switch to Post Messages Enabled during POST, press any key (except F1
through F12).

Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

Enter the Asset Tag or property identification number assigned by the company to this computer.
Enable the power-on password prompt during system restarts (warm boots) as well as during power-on.

Establish a setup password that controls access to the Computer Setup (F10) Utility and the settings
described in this section.

Secure integrated I/0 functionality, including the serial, USB, or parallel ports, audio, or embedded NIC,
so that they cannot be used until they are unsecured.

Enable or disable removable media boot ability.

Solve system configuration errors detected but not automatically fixed during the Power-0n Self-Test
(POST).

Replicate the system setup by saving system configuration information on a USB device and restoring it
on one or more computers.

Enable or disable DriveLock security (when supported by drive).

Using Computer Setup (F10) Utilities

Computer Setup can be accessed only by turning the computer on or restarting the system. To access the
Computer Setup Utilities menu, complete the following steps:

1.
2.

Turn on or restart the computer.
Repeatedly press F10 when the monitor light turns green to access the utility.

You can also press Esc to a menu that allows you to access different options available at startup,
including the Computer Setup utility.

[%f’ NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again

repeatedly press F10 when the monitor light turns green to access the utility.
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3. Achoice of four headings appears in the Computer Setup Utilities menu: Main, Security, Advanced, and
UEFI Drivers.

[)_ﬁ”f NOTE: Selecting UEFI Drivers restarts the computer into the 3rd party option ROM management
application. You can access this application directly by pressing F3 during startup.

4. Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down) keys
to select the option you want, then press Enter. To return to the Computer Setup Utilities menu, press
Esc.

5. Toapply and save changes, select Main > Save Changes and Exit.
e If you have made changes that you do not want applied, select Ignore Changes and Exit.

e  Toreset to factory settings or previously saved default settings (some models), select Apply
Factory Defaults and Exit. This option will restore the original factory system defaults.

[%f’ NOTE: Not all settings shown in the following sections are available for all models

A CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup (F10) changes
because the CMOS could become corrupted. It is safe to turn off the computer only after exiting the F10 Setup
screen.

Computer Setup (F10) Utilities
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Computer Setup—Main

[%f NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 5-1 Computer Setup—Main

Option Description

System Information Lists all information in following list if Advanced System Information is selected. Lists smaller subset if
Basic System Information is selected.

e Product name

° Installed memory size

. Processor type

e  Processor cache size (L1/L2/L3)

° Processor speed

e  MicroCode Revision

° Processor Stepping

e  DIMMsize (for each installed module)
e System BIOS version

° Integrated Video BiOS Revision

e  BornOnDate

e  Serial Number

e SKUnumber

e UUID (Universally Unique Identifier)
o  Asset Tracking Number

° Feature Byte

e BuildID

° Product Family

e  SystemBoard ID

e  System Board CT

e  Integrated MAC Address

System Diagnostics Starts HP PC Hardware Diagnostics UEFI.
Lets you perform the following functions:
° Memory Test
e Hard Drive Check

o Language

Update System BIOS Lets you update the system BIOS. BIOS update binary (BIN) files must be located on the system hard drive
or on a removable USB drive under the “Hewlett-Packard\BIOS\New” folder or under the “EFI\HP\BIOS
\New” folder.

Set Machine Unique Data Lets you update the following values:
° Feature Byte

° Build ID
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Table 5-1 Computer Setup—RMain (continued)

Option

Description

Serial Number
SKU Number
Product Family
System Board CT

Product Name

System IDs

Lets you clear the following values:

Asset Tracking Number

Ownership Tag

Replicated Setup

Backup current settings to USB device

Saves system configuration to a formatted USB flash media device.

Restore current settings from USB device
Restores system configuration from a USB flash media device.

NOTE:

In order to protect system security, this feature does not support replicating passwords. Use the
BIOS Configuration Utility instead.

Save Custom Defaults

Saves the current system configuration settings as the default.

Apply Custom Defaults Applies the currently selected default settings and clears any established passwords.
and Exit

Apply Factory Defaults Restores the factory system configuration settings as the default.

and Exit

Ignore Changes and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and Exit

Saves changes to system configuration or default settings and exits Computer Setup.

Computer Setup (F10) Utilities
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Computer Setup—Security

[%f NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 5-2 Computer Setup—Security

Option Description

Set up BIOS Lets you set and enable a BIOS administrator password, which includes the following privileges:
Administrator Password

e  Manage other BIOS users

° Full access to BIOS policy and settings

e  (Control BIOS access of other users by setting security level

° Unlock the computer when other BIOS users fail the preboot authentication.
NOTE: Creating a BIOS user disables the Fast Boot option.

NOTE: If the password is set, it is required to change Computer Setup options, flash the ROM, and make
changes to certain plug and play settings under Windows.

Change BIOS Lets you change the BIOS administrator password.

Administrator Password .
You must know the current password to be able to change it.

(This selection is active
only if a BIOS
administrator password is
set.)

Password Policy Let you set the guidelines for a valid password. Options include:
° Password minimum length
° Requires at least one symbol
° Requires at least one number
° Requires at least one upper case character
° Requires at least one lower case character
e  Allow spaces
Clear Password Jumper

Select ‘Honor’ to engage or ‘Ignore’ to disengage the password jumper. Default is ‘Honor’.

Security Configuration Lets you activate HP SureStart.
Verify Boot Block on ever Boot
Select to enable HP SureStart.
BIOS Data Recovery Policy

Select ‘Automatic’ or ‘Manual’ to determine data recovery process.

TPM Embedded Security  TPM Device
Lets you set the Trusted Platform Module as available or hidden.
TPM State
Select to enable the TPM.
TPM Clear

Select to reset the TPM to an unowned state. After the TPM is cleared, it is also turned off. To temporarily
suspend TPM operations, turn the TPM off instead of clearing it.
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Table 5-2 Computer Setup—Security (continued)

Option

Description

CAUTION: Clearing the TPM resets it to factory defaults and turns it off. You will lose all created keys and
data protected by those keys.

Set Up BIOS Power-On
Password

Lets you set and enable a BIOS power-on password. The power-on password prompt appears after a
power cycle or reboot. If the user does not enter the correct power-on password, the unit will not boot.

Change BIOS Power-On
Password

(This selection is active
only if a BIOS power-on
password is set.)

Lets you change the BIOS power-on password.

You must know the current password to be able to change it.

DriveLock

Allows you to assign or modify a master or user password for hard drives. When this feature is enabled,
the user is prompted to provide one of the DriveLock passwords during POST. If neither is successfully
entered, the hard drive will remain inaccessible until one of the passwords is successfully provided during
a subsequent cold-boot sequence.

NOTE: This selection will only appear when at least one drive that supports the DriveLock feature is
attached to the system.

CAUTION: Be aware that these settings take place immediately. A save is not necessary.

CAUTION: Be sure to document the DriveLock password. Losing a DriveLock password will render a drive
permanently locked.

After you select a drive, the following options are available:
Set DriveLock Master Password. Sets the drive’s master password but does not enable DriveLock.

Enable DriveLock. Sets the drive’s user password and enables DriveLock.

Secure Erase

Lets you select a hard drive to completely erase.

Once a hard drive has been erased with a program that utilizes Secure Erase firmware commands, no file
recovery program, partition recovery program, or other data recovery method will be able to extract data
from the drive.

Save/Restore MBR of the
system hard drive

Enabling this feature will save the Master Boot Record (MBR) of the system hard drive. If the MBR gets
changed, the user will be prompted to restore the MBR. Default is disabled.

The MBR contains information needed to successfully boot from a disk and to access the data stored on
the disk. Master Boot Record Security may prevent unintentional or malicious changes to the MBR, such as
those caused by some viruses or by the incorrect use of certain disk utilities. It also allows you to recover
the "last known good" MBR, should changes to the MBR be detected when the system is restarted.

When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the current
bootable disk while in MS-DOS or Windows Safe Mode.

NOTE: Most operating systems control access to the MBR of the current bootable disk; the BIOS cannot
prevent changes that may occur while the operating system is running.

Restores the backup Master Boot Record to the current bootable disk. Default is disabled.
Only appears if all of the following conditions are true:

° MBR security is enabled

e Abackup copy of the MBR has been previously saved

° The current bootable disk is the same disk from which the backup copy was saved

CAUTION: Restoring a previously saved MBR after a disk utility or operating system has modified the
MBR, may cause the data on the disk to become inaccessible. Only restore a previously saved MBR if you
are confident that the current bootable disk's MBR has been corrupted or infected with a virus.

Smart Cover

Cover Lock (Lock/Unlock)
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Table 5-2 Computer Setup—Security (continued)

Option

Description

Default is ‘Unlock’.
Cover Removal Sensor (Disabled/Notify user/Administrator password)

Lets you disable the cover sensor or configure what action is taken if the computer cover was removed.
Default is ‘Disabled’.

NOTE: Notify user alerts the user that the sensor has detected that the cover has been removed.
Administrator Password requires that the password be entered to boot the computer if the sensor
detects that the cover has been removed.

System Management
Command

Allows authorized personnel to reset security settings during a service event. Default is enabled.

Restore Security
Settings to Default

Restoring settings to default requires the BIOS Administrator password.

Computer Setup—Advanced

[i-'_%f’ NOTE: Support for specific Computer Setup options may vary depending on the hardware configuration.

Table 5-3 Computer Setup—Advanced (for advanced users)

Option Heading

Select Language Lets you select the language of the menus in F10 Setup.
Select Keyboard Layout Lets you select language for the keyboard.

Boot Options Startup Menu Delay(sec)

Enabling this feature will add a user-specified delay to the POST process. This delay is sometimes needed
for hard disks on some PCl cards that spin up very slowly, so slowly that they are not ready to boot by the
time POST is finished. The POST delay also gives you more time to select F10 to enter Computer (F10)
Setup. Default is ‘0".

Select the devices that the computer can boot from, as well as other options, including:
e  Fast Boot. Default is disabled.

e  (CD-ROM Boot. Default is enabled.

e Network (PXE) Boot. Default is enabled.

e SDBoot. Default is enabled.

e Netclone BIOS Boot. Default is disabled.

e  Prompt on Memory Size Change. Default is enabled.

° Prompt on Fixed Storage Change. Default is disabled.

° Display Diagnostic URL. Default is enabled.

e UEFI Boot Order. Default is enabled.

° Specify the order in which UEFI boot sources (such as a internal hard drive, USB hard drive, USB
optical drive, or internal optical drive) are checked for a bootable operating system image. Each
device on the list may be individually excluded from or included for consideration as a bootable
operating system source.

UEFI boot sources always have precedence over legacy boot sources.

e  LegacyBoot Order
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Table 5-3 Computer Setup—Advanced (for advanced users) (continued)

Option

Heading

Specify the order in which legacy boot sources (such as a network interface card, internal hard drive,
USB optical drive, or internal optical drive) are checked for a bootable operating system image. Each
device on the list may be individually excluded from or included for consideration as a bootable
operating system source.

Specify the order of attached hard drives. The first hard drive in the order will have priority in the
boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: To drag a device to a preferred place, press Enter. To remove the device from consideration as a
bootable device, press F5.

You can use F5 to disable individual boot items, as well as disable UEFI boot and/or legacy boot.

NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating system has
started.

Shortcut to Temporarily Override Boot Order

To boot one time from a device other than the default device specified in Boot Order, restart the computer
and press Esc (to access the boot menu) and then F9 (Boot Order), or only F9 (skipping the boot menu)
when the monitor light turns green. After POST is completed, a list of bootable devices is displayed. Use
the arrow keys to select the preferred bootable device and press Enter. The computer then boots from the
selected non-default device for this one time.

Secure Boot

Configure Legacy Support and Secure Boot

Configuration
Legacy Support — Lets you turn off all legacy support on the computer, including booting to DOS, running
legacy graphics cards, booting to legacy devices, and so on.
Secure Boot — Lets you make sure an operating system is legitimate before booting to it, making Windows
resistant to malicious modification from preboot to full OS booting, preventing firmware attacks. UEFI and
Windows Secure Boot only allow code signed by pre-approved digital certificates to run during the
firmware and OS boot process.
Default is ‘Legacy Support Enable and Secure Boot Disable’.
Secure Boot Key Management
Lets you manage the custom key settings.
Clear Secure Boot Keys
Lets you delete any previously loaded custom boot keys. Clearing keys will disable secure boot. Default is
disabled.
Reset Security Boot keys to factory defaults
Default is disabled.

System Options Onboard RAID (enable/disable)

Lets you enable onboard RAID. Default is disabled.

Max SATA Speed (6.0 Gbps/3.0Gbps)

Lets you set the maximum SATA drive speed to either 3.0 Gbps or 6.0 Gbps. The default is ‘6.0 Gbps'.
USB 3.0 (XHCI) (enable/disable)

Lets you enable the eXtensible Host Controller Interface (xHCI). If enabled, the USB 3.0 ports are routed to
the xHCI controller before booting to 0S. If disabled, the USB 3.0 ports are routed to the EHCI controller
before booting to 0S. The default is disabled.

After Power Loss (off/on/previous state). Default is Power off. Setting this option to:
e  Power off—causes the computer to remain powered off when power is restored.

e  Power on—causes the computer to power on automatically as soon as power is restored.
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Table 5-3 Computer Setup—Advanced (for advanced users) (continued)

Option

Heading

° Previous state—causes the computer to power on automatically as soon as power is restored, if it
was on when power was lost.

SVM CPU Virtualization (enable/disable)

Controls the virtualization features of the processor. Changing this setting requires turning the computer
off and then back on. Default is disabled.

Allow PCle/PCI SERR# Interrupt (enable/disable)

Allows PCl devices to report PCI/PCle System Error signals, such as address parity errors, data parity
errors, and critical errors other than parity. Default is enabled.

Power Button Override (disable/4 sec/15 sec)

Lets you disable or enable and select the number of seconds you have to hold down the power button for
it to override the system. Default is ‘4 sec’.

Built-In Device Options

Embedded LAN Controller
Select to show the device in the operating system. Default is enabled.
Wake On LAN

Lets you either disable the Wake On LAN feature, or configure where the computer boots, including the
network or hard drive. Default is Boot to Network.

Embedded WWAN Device
Select to enable.
Video Memory Size

Use this option to manage graphics memory allocation. The value you choose is allocated permanently to
graphics and is unavailable to the operating system. For example, if you set this value to 512M on a
system with 2 GB of RAM, the system always allocates 512 MB for graphics and the other 1.5 GB for use by
the BIOS and operating system. Default is ‘Auto’ which sets memory allocation to 512 MB.

Audio Device

Select to show the device in the operating system. Default is enabled.
Internal Speakers (does not affect external speakers)

Select to show the device in the operating system. Default is enabled.
Integrated Microphone

Select to show the device in the operating system. Default is enabled.
Integrated Camera

Use this option to disable the integrated video controller when another video controller is present in the
system. Default is enabled.

Increase Idle Fan Speed(%)

Sets idle fan speed percentage. This setting only changes the minimum fan speed. The fan is still
automatically controlled.

Fingerprint Device
Select to show the device in the operating system. Default is enabled.
Touch Panel

Select to show the device in the operating system. Default is enabled.

Port Options

Allows you to hide the following ports from the operating system:
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Table 5-3 Computer Setup—Advanced (for advanced users) (continued)

Option Heading

° Serial port A

e  SATAO
e  SATA1
e  SATA2

° Front USB ports

e  Rear USB ports

e  Media card reader

Restrict USB Devices

Specify the following categories of USB devices to enable:
e Allow all USB devices

e  Allow only keyboard and mouse

e  Allow all but storage devices and hubs.

Option ROM Launch These policies control whether the Legacy Option ROM or the UEFI driver is loaded. Default is ‘All UEFI'.
Pollcy Configure Option ROM Launch Policy

° All legacy

e AIUEFI

e  All UEFI except video

Power Management Runtime Power Management (enable/disable)

Options
Allows certain operating systems to reduce processor voltage and frequency when the current software
load does not require the full capabilities of the processor. Default is enabled.
Extended Idle Power States (enable/disable)

Allows certain operating systems to decrease the processors power consumption when the processor is
idle. Default is enabled.

S5 Maximum Power Savings (enable/disable)

Enabling this feature reduces the power of the system as much as possible in the S5 state. Power is
removed from the wake up circuitry, the expansion slots, and any management features while in S5.
Default is disabled.

SATA Power Management (enable/disable)
Enables or disables SATA bus and/or device power management. Default is enabled.
PCI Express Power Management (enable/disable)

Enabling this option permits the PCI Express links to use Active Power State Management (ASPM) to enter
lower power states while not in use. Default is enabled.

Unique Sleep State Blink Rates (enable/disable)

This feature is designed to provide a visual indication of what sleep state the system is in. Each sleep
state has a unique blink pattern. Default is disabled.

NOTE: A normal shutdown goes to the S4 state.
S0 (On) = Solid white LED.

S3 (Stand By)= 3 blinks at THz (50% duty cycle) followed by a pause of 2 seconds (white LED) — repeated
cycles of 3 blinks and a pause.
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Table 5-3 Computer Setup—Advanced (for advanced users) (continued)

Option Heading
S4 (Hibernation)= 4 blinks at THz (50% duty cycle) followed by a pause of 2 seconds (white LED) —
repeated cycles of 4 blinks and a pause.
S5 (Soft Off) = LED is off.
Power On from Keyboard Ports (enable/disable)
Enables or disables waking from S3 due to any keyboard activity. Default is disabled.
USB Charging Port Function (enable/disable)
Enables or disables the charging capability of the USB charging port. Default is enabled.
Configurations Allows you to use F10 Setup to check for BIOS updates and apply them using either a manual selection or
an automatically scheduled check upon boot-up.
NOTE: If Windows BitLocker Drive Encryption (BDE) is enabled, HP requires that BDE be suspended
temporarily before the BIOS is flashed. You must get the BDE recovery password and PIN before
suspending BDE. After updating the BIOS, you can resume BDE.
Update Source (HP/Custom)
Selects hp.com or a locally managed custom address to serve BIOS updates. Default is ‘HP’".
Update Address.
If ‘Custom’ is selected for Update Source, enter the URL of the locally managed server.
Update BIOS via Network (Enabled/Disable)
Enables or disables the network BIOS update scheduler. Default is ‘Enable’.
Automatic Update Frequency (Daily, Weekly, Monthly)
If ‘Enable’ is selected for Update BIOS via Network, sets the frequency of checks to the BIOS update
server. If a newer version of BIOS is available on the network server, the system will prompt to update the
BIOS. Default is ‘Daily’.
Automatic BIOS Update Setting
If ‘Enable’ is selected for Update BIOS via Network, during the next boot, checks whether an updated
BIOS is available and installs only specified updates. This value is independent of the Automatic Update
Frequency setting.
Available configurations include:
e  Check and install all BIOS updates automatically
° Check and install only important updates automatically
° Check for BIOS updates but let me decide whether to install them
Default is ‘Check and install all BIOS updates automatically’.
Check for updates now Select to check for the latest BIOS release revision on the network. Lets you decide whether to download

the BIOS image and update the system.

Scheduled Power-0On

This feature wakes the system up from a powered off state at a specified date and time.
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Recovering the Configuration Settings

This method of recovery requires that you first perform the Save to Removable Media command with the
Computer Setup (F10) Utility before Restore is needed. (See Computer Setup—Main on page 54 in the

Computer Setup—rFile table.)

E?’”f NOTE: Itis recommended that you save any modified computer configuration settings to a USB flash media
device and save the device for possible future use.

To restore the configuration, insert the USB flash media device with the saved configuration and perform the
Restore from Removable Media command with the Computer Setup (F10) Utility. (See Computer Setup—Main

on page 54 in the Computer Setup—File table.)
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Troubleshooting without diagnostics

This chapter provides information on how to identify and correct minor problems, such as USB devices, hard
drive, optical drive, graphics, audio, memory, and software problems. If you encounter problems with the
computer, refer to the tables in this chapter for probable causes and recommended solutions.

[%/r NOTE: Forinformation on specific error messages that may appear on the screen during Power-0n Self-Test

(POST) at startup, refer to POST error messages and diagnostic front panel LEDs and audible codes
on page 94.

Safety and comfort

64

A WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment may

result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/ergo for
more information on choosing a workspace and creating a safe and comfortable work environment. For more
information, refer to the Safety & Regulatory Information guide.

Before you call for technical support

If you are having problems with the computer, try the appropriate solutions below to try to isolate the exact
problem before calling for technical support.

e  Runthe HP diagnostic tool.

e  Run the hard drive self-test in Computer Setup. Refer to Computer Setup (F10) Utility on page 52 for
more information.

e  Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are error
codes that will help you diagnose the problem. Refer to POST error messages and diagnostic front panel
LEDs and audible codes on page 94 for more information.

e If the screenis blank, plug the monitor into a different video port on the computer if one is available. Or,
replace the monitor with a monitor that you know is functioning properly.

e If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

e If yourecently added new hardware, remove the hardware and see if the computer functions properly.
e If yourecently installed new software, uninstall the software and see if the computer functions properly.

° Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When booting
the operating system, use “Last Known Configuration.”

e  Refer to the comprehensive online technical support at http://www.hp.com/support.

e  Refer to Helpful hints on page 65 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with self-
solve diagnostics. If you need to contact HP support, use HP Instant Support Professional Edition's online chat
feature. Access HP Instant Support Professional Edition at: http://www.hp.com/go/ispe.

Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online support
information, software and drivers, proactive notification, and worldwide community of peers and HP experts.
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If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that your
service call is handled properly:

Be in front of your computer when you call.

Write down the computer serial number, product ID number, and monitor serial number before calling.
Spend time troubleshooting the problem with the service technician.

Remove any hardware that was recently added to your system.

Remove any software that was recently installed.

Restore the system from the Recovery Disc Set that you created or restore the system to its original
factory condition in System Software Requirement Disks (SSRD).

A CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data files before
running the restore process.

[:;’/f’ NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized service provider
or dealer.

Helpful hints

If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:

Check that the computer and monitor are plugged into a working electrical outlet.

Check that the voltage select switch (some models) is set to the appropriate voltage for your region
(115V or 230V).

Check that the computer is turned on and the white power light is on.
Check that the monitor is turned on and the green monitor light is on.

Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are error
codes that will help you diagnose the problem. Refer to POST error messages and diagnostic front panel
LEDs and audible codes on page 94 for more information.

Turn up the brightness and contrast controls of the monitor if the monitor is dim.
Press and hold any key. If the system beeps, then the keyboard should be operating correctly.
Check all cable connections for loose connections or incorrect connections.

Wake the computer by pressing any key on the keyboard or pressing the power button. If the system
remains in suspend mode, shut down the computer by pressing and holding the power button for at
least four seconds then press the power button again to restart the computer. If the system will not shut
down, unplug the power cord, wait a few seconds, then plug it in again. The computer will restart if it is
set to power on automatically as soon as power is restored in Computer Setup. If it does not restart,
press the power button to start the computer.

Reconfigure the computer after installing a non-plug and play expansion board or other option. See
Solving Hardware Installation Problems on page 82 for instructions.

Be sure that all the needed device drivers have been installed. For example, if you are using a printer,
you need a driver for that model printer.

Remove all bootable media (CD/DVD or USB device) from the system before turning it on.
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e If you have installed an operating system other than the factory-installed operating system, check to be
sure that it is supported on the system.

e |f the system has multiple video sources (embedded, PCl, or PCI-Express adapters) installed (embedded
video on some models only) and a single monitor, the monitor must be plugged into the monitor
connector on the source selected as the primary VGA adapter. During boot, the other monitor connectors
are disabled and if the monitor is connected into these ports, the monitor will not function. You can
select which source will be the default VGA source in Computer Setup.

A CAUTION: When the computer is plugged into an AC power source, there is always voltage applied to the

system board. You must disconnect the power cord from the power source before opening the computer to
prevent system board or component damage.

Solving general problems

66

You may be able to easily resolve the general problems described in this section. If a problem persists and you
are unable to resolve it yourself or if you feel uncomfortable about performing the operation, contact an
authorized dealer or reseller.

A WARNING! When the computer is plugged into an AC power source, voltage is always applied to the system

board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to disconnect
the power cord from the wall outlet and allow the internal system components to cool before touching.

Cannot access the Computer Setup (F10) Utility when booting the computer.

Cause Solution

The Computer Setup (F10) Utility is set to “fast boot” causing the ~ Before turning on the computer, press and hold F10. Turn on the
F10 access screen to display too briefly when booting the computer and continue to hold F10 until the Computer Setup
computer. (F10) Utility is displayed.

-or-—

Follow the Windows instructions for rebooting the computer into
the Computer Setup (F10) Utility.

Computer appears locked up and will not turn off when the power button is pressed.

Cause Solution

Software control of the power switch is not functional. 1. Press and hold the power button for at least four seconds
until the computer turns off.

2. Disconnect the power cord from the electrical outlet.

Computer will not respond to keyboard or mouse.

Cause Solution

Computer is in Sleep state. To resume from Sleep state, press the power button.

CAUTION: When attempting to resume from Sleep state, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

System has locked up. Restart computer.
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Computer date and time display is incorrect.

Cause

Solution

RTC (real-time clock) battery may need to be replaced.

NOTE: Connecting the computer to a live AC outlet prolongs the
life of the RTC battery.

Reset the date and time under Control Panel (Computer Setup
can also be used to update the RTC date and time). If the problem
persists, replace the RTC battery. See the Removal and
Replacement section for instructions on installing a new battery,
or contact an authorized dealer or reseller for RTC battery
replacement.

To access Control Panel in Windows 7, select Start, and then
select Control Panel.

To access Control Panel in Windows 10, type control panelin
the taskbar search box, and then select Control Panel.

There is no sound or sound volume is too low.

Cause

Solution

System volume may be set low or muted.

1. Check the Computer Setup settings to make sure the
internal system speaker is not muted (this setting does not
affect the external speakers).

2. Make sure the external speakers are properly connected and
powered on and that the speakers' volume control is set
correctly.

3.  Use the system volume control available in the operating
system to make sure the speakers are not muted or to
increase the volume.

Cannot remove computer cover or access panel.

Cause

Solution

Smart Cover Lock, featured on some computers, is locked.

Unlock the Smart Cover Lock using Computer Setup.

In case of forgotten password, power loss, or computer
malfunction, you must manually disable the Smart Cover lock . A
key to unlock the Smart Cover Lock is not available from HP. Keys
are typically available from a hardware store.

Poor performance.

Cause

Solution

Processor is too hot.

1. Make sure airflow to the computer is not blocked. Leave a
10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2.  Make sure fans are connected and working properly (some
fans only operate when needed).

3.  Make sure the processor heat sink is installed properly.

Hard drive is full.

Transfer data from the hard drive to create more space on the
hard drive.
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Poor performance.

Cause

Solution

Low on memory.

Add more memory.

Hard drive fragmented.

Defragment hard drive.

Program previously accessed did not release reserved memory
back to the system.

Restart the computer.

Virus resident on the hard drive.

Run virus protection program.

Too many applications running.

1.

2.

Close unnecessary applications to free up memory.
Add more memory.

Some applications run in the background and can be closed
by right-clicking on their corresponding icons in the task
tray. To prevent these applications from launching at
startup:

In Windows 7:
a. Goto Start > All Programs > Accessories > Run
b. Typemsconfig, andthen press Enter.

¢.  Onthe Startup tab of the System Configuration Utility,
clear applications that you do not want to launch
automatically, and the click OK.

In Windows 10:

a. Typemsconfigin the taskbar search box, and then
select msconfig.

b.  On the Startup tab of the System Configuration Utility,
click Open Task Manager.

¢.  Select applications that you do not want to launch
automatically, and the click Disable.

Some software applications, especially games, are stressful on
the graphics subsystem.

1.

Lower the display resolution for the current application or
consult the documentation that came with the application
for suggestions on how to improve performance by
adjusting parameters in the application.

Add more memory.

Upgrade the graphics solution.

Cause unknown.

Restart the computer.

Computer powered off automatically and the Power LED flashes red four times and then white two times.

Cause Solution
Processor thermal protection activated: 1. Ensure that the computer air vents are not blocked and the
. processor cooling fan is running.
A fan may be blocked or not turning.
2. Openthe access panel, press the power button, and see if
OR the processor fan (or other system fan) spins. If the fan does
The heat sink is not properly attached to the processor. not spin, make sure the fan cable is plugged onto the system
board header.
3. Iffanaplugged in and not spinning, replace it.
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System does not power on and the LEDs on the front of the computer are not flashing.

Cause

Solution

System unable to power on.

Press and hold the power button for less than 4 seconds. If the
hard drive LED turns white, then:

1.

3.
OR

If equipped with a voltage selector, check that the voltage
selector (located on the rear of the power supply) is set to
the appropriate voltage. Proper voltage setting depends on
your region.

Remove the expansion cards one at a time until the 5V_aux
light on the system board turns on.

Replace the system board.

Press and hold the power button for less than 4 seconds. If the
hard drive LED does not turn on white then:

1.

2.

Check that the unit is plugged into a working AC outlet.

Open the access panel and check that the power button
cable is properly connected to the system board.

Check that the power supply cables are properly connected
to the system board.

Check to see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power button
assembly.

If the 5V_aux light on the system board is off, then replace
the power supply.

Replace the system board.
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Solving power problems

Common causes and solutions for power problems are listed in the following table.

Power supply shuts down intermittently.

Cause Solution

If equipped with a voltage selector, voltage selector switch on Select the proper AC voltage using the selector switch.
rear of computer chassis (some models) not switched to correct
line voltage (115V or 230V).

Power supply will not turn on because of internal power supply Replace the power supply.
fault.

Computer powered off automatically and the Power LED flashes Red two times, once every second, followed by a two second
pause, and the computer beeps two times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Computer powered off automatically and the Power LED flashes red four times and then white two times.

Cause Solution

Processor thermal protection activated: 1. Ensure that the computer air vents are not blocked and the

processor cooling fan is running.
A fan may be blocked or not turning.

2. Openthe access panel, press the power button, and see if
the processor fan (or other system fan) spins. If the fan does
not spin, make sure the fan cable is plugged onto the system
board header.

OR

The heat sink is not properly attached to the processor.

3. If fan a plugged in and not spinning, replace it.

Power LED flashes Red four times, once every second, followed by a two second pause, and the computer beeps four times. (Beeps
stop after fifth iteration but LEDs continue flashing.)

Computer powered off automatically and the Power LED flashes red three times and then white four times.

Cause Solution

Power failure (power supply is overloaded). 1.  If equipped with a voltage selector, check that the voltage
selector, located on the rear of the power supply (some
models), is set to the appropriate voltage. Proper voltage
setting depends on your region.

2. Open the access panel and ensure the power supply cable is
seated into the connector on the system board.

3.  Checkif a device is causing the problem by removing ALL
attached devices (such as hard drives or optical drives and
expansion cards). Power on the system. If the system enters
POST, then power off and replace one device at a time and
repeat this procedure until failure occurs. Replace the device
that is causing the failure. Continue adding devices one at a
time to ensure all devices are functioning properly.

4. Replace the power supply.

5. Replace the system board.
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Solving hard drive problems

Hard drive error occurs.

Cause

Solution

Hard disk has bad sectors or has failed.

1. InWindows 7, click Start, click Computer, and right-click on
adrive. Select Properties, and then select the Tools tab.
Under Error-checking click Check Now.

In Windows 10, type £i 1e in the taskbar search box, and
then select File Explorer from the list of applications. In the
left column, expand This PC, right-click on a drive, select
Properties, and then select the Tools tab. Under Error
checking click Check.

2. Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

Disk transaction problem.

Cause

Solution

Either the directory structure is bad or there is a problem with a

file.

In Windows 7, click Start, expand Computer, and right-click on a
drive. Select Properties, and then select the Tools tab. Under
Error-checking click Check Now.

In Windows 10, type f£ile in the taskbar search box, and then
select File Explorer from the list of applications. In the left
column, expand This PC, right-click on a drive, select Properties,
and then select the Tools tab. Under Error checking click Check.

Drive not found (identified).

Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly

installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 82 section. If the system still

does not recognize the new device, check to see if the device is
listed within Computer Setup. If it is listed, the probable cause is a
driver problem. If it is not listed, the probable cause is a hardware
problem.

If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > Boot Options.

The device is attached to a SATA port that has been hidden in

Computer Setup.

Run the Computer Setup utility and ensure Device Available is
selected for the device's SATA port in Advanced > Port Options.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in Advanced >
Boot Options.
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Nonsystem disk/NTLDR missing message.

Cause

Solution

The system is trying to start from the hard drive but the hard
drive may have been damaged.

A Perform Drive Protection System (DPS) testing in system
ROM.

System files missing or not properly installed.

1. Insert bootable media and restart the computer.

2. Boot to the windows installation media and select the
recovery option. If only a restore kit is available, then select
the File Backup Program option, and then restore the
system.

3. Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup.

Run the Computer Setup utility and enable the hard drive entry in
the Advanced > Boot Options list.

Bootable hard drive is not attached as first in a multi-hard drive
configuration.

If attempting to boot from a hard drive, ensure it is attached to
the system board dark blue SATA connector.

Bootable hard drive is not listed first in the Boot Order.

Run the Computer Setup utility and select Advanced > Boot
Options and ensure the bootable hard drive is listed immediately
under the Hard Drive entry.

Computer will not boot from hard drive.

Cause

Solution

The device is attached to a SATA port that has been hidden in
Computer Setup.

1. Check SATA cable connections.

2. Runthe Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Advanced > Port
Options.

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Advanced > Boot Options.

Hard drive is damaged.

Observe if the front panel Power LED is blinking RED and if any
beeps are heard. See POST error messages and diagnostic front
panel LEDs and audible codes on page 94 to determine possible
causes for the blinking red and beep codes.

See the Worldwide Limited Warranty for terms and conditions.

Computer seems to be locked up.

Cause

Solution

Program in use has stopped responding to commands.

1. Use the task manager to close programs that do not
respond.

2.  Attempt the normal Windows “Shut Down” procedure. If this
fails, press the power button for four or more seconds to
turn off the power. To restart the computer, press the power
button again.
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Solving media card reader problems

Media card will not work in a digital camera after formatting it in Windows.

Cause Solution

By default, Windows will format any media card with a capacity Either format the media card in the digital camera or select FAT
greater than 32MB with the FAT32 format. Some digital cameras file system to format the media card in a computer with Windows.
use the FAT (FAT16 & FAT12) format and can not operate with a

FAT32 formatted card.

A write-protected or locked error occurs when attempting to write to the media card.

Cause Solution

Media card is locked. Locking the media card is a safety feature If using an SD card, make sure that the lock tab located on the
that prevents writing to and deleting from an SD/Memory right of the SD card is not in the locked position. If using a Memory
Stick/PRO card. Stick/PRO card, make sure that the lock tab located on the bottom

of the Memory Stick/PRO card is not in the locked position.

Can not write to the media card.

Cause Solution

The media card is a read-only memory (ROM) card. Check the manufacturer’s documentation included with your card
to see if it writable. Refer to the previous section for a list of
compatible cards.

Media card is locked. Locking the media card is a safety feature If using an SD card, make sure that the lock tab located on the
that prevents writing to and deleting from an SD/Memory right of the SD card is not in the locked position. If using a Memory
Stick/PRO card. Stick/PRO card, make sure that the lock tab located on the bottom

of the Memory Stick/PRO card is not in the locked position.

Unable to access data on the media card after inserting it into a slot.

Cause Solution

The media card is not inserted properly, is inserted in the wrong Ensure that the card is inserted properly with the gold contact on
slot, or is not supported. the correct side. The green LED will light if inserted properly.

Do not know how to remove a media card correctly.

Cause Solution

The computer’s software is used to safely eject the card. In Windows 7, click Start, select Computer, right-click on the
corresponding drive icon, and then select Eject. Pull the card out
of the slot.

In Windows 10, type £i 1e in the taskbar search box, and then
select File Explorer from the list of applications. In the left
column, expand This PC, right-click on the corresponding drive
icon, and then select Eject. Pull the card out of the slot.

NOTE: Never remove the card when the green LED is flashing
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After installing the media card reader and booting to Windows, the reader and the inserted cards are not recognized by the

computer.

Cause

Solution

The operating system needs time to recognize the device if the
reader was just installed into the computer and you are turning
the PC on for the first time.

Wait a few seconds so that the operating system can recognize
the reader and the available ports, and then recognize the media
inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.

Cause

Solution

The inserted media card has boot capability.

1.  If you do not want to boot from the media card, remove it
during boot or do not select the option to boot from the
inserted media card during the boot process.

2. During POST (Power On Self-Test), press F9 to modify the
boot menu.

3. Change the boot sequence in F10 Computer Setup.

Solving display problems

If you encounter display problems, see the documentation that came with the monitor and to the common

causes and solutions listed in the following table.

Blank screen (no video).

Cause

Solution

Monitor is not turned on and the monitor light is not on.

Turn on the monitor and check that the monitor light is on.

Bad monitor.

Try a different monitor.

The cable connections are not correct.

Check the cable connection from the monitor to the computer and
to the electrical outlet.

You may have a screen blanking utility installed or energy saver
features are enabled.

Press any key or click the mouse button and type your password
(if set).

System ROM is corrupted; system is running in Boot Block
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image.

You are using a fixed-sync monitor and it will not sync at the
resolution chosen.

Be sure that the monitor can accept the same horizontal scan rate
as the resolution chosen.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Monitor cable is plugged into the wrong connector.

Systems may have a monitor connection on both the
motherboard or an add-in card. Try moving the monitor
connection to a different connector on the back of the computer

Monitor settings in the computer are not compatible with the
monitor.
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Blank screen (no video).

Cause Solution

To access Control Panel in Windows 7, click Start, and then
select Control Panel.

To access Control Panel in Windows 10, type control
panel in the taskbar search box, and then select Control
Panel from the list of applications.

2. Expand the Resolution box, and then use the sliding control
to reset the resolution.

Monitor is configured to use an input that is not active. Use the monitor's on-screen menu controls to select the input
that is being driven by the system. Refer to the monitor's user
documentation for more information on the on-screen controls
and settings.

Blank screen and the power LED flashes Red five times, once every second, followed by a two second pause, and the computer
beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video memory error. 1. Reseat DIMMs. Power on the system.
2. Replace DIMMs one at a time to isolate the faulty module.
3.  Replace third-party memory with HP memory.

4. Replace the system board.

Blank screen and the power LED flashes Red six times, once every second, followed by a two second pause, and the computer
beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

Pre-video graphics error. For systems with a graphics card:

1. Reseat the graphics card (if applicable). Power on the
system.

2.  Replace the graphics card (if applicable).
3. Replace the system board.

For systems with integrated graphics, replace the system board.

Blank screen and the power LED flashes Red seven times, once every second, followed by a two second pause, and the computer
beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)

Cause Solution

System board failure (ROM detected failure prior to video). Replace the system board.
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Monitor does not function properly when used with energy saver features.

Cause

Solution

Monitor without energy saver capabilities is being used with
energy saver features enabled.

Disable monitor energy saver feature.

Dim characters.

Cause

Solution

The brightness and contrast controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly connected.

Check that the graphics cable is securely connected to the
graphics card (if applicable) or video connector and the monitor.

Blurry video or requested resolution cannot be set.

Cause

Solution

If the graphics controller was upgraded, the correct graphics
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution.

Change requested resolution.

Graphics card is bad.

Replace the graphics card.

The picture is broken up, rolls, jitters, or flashes.

Cause

Solution

The monitor connections may be incomplete or the monitor may
be incorrectly adjusted.

1. Besure the monitor cable is securely connected to the
computer.

2.  Inatwo-monitor system or if another monitor is in close
proximity, be sure the monitors are not interfering with each
other’s electromagnetic field by moving them apart.

3.  Fluorescent lights or fans may be too close to the monitor.

Monitor needs to be degaussed.

Degauss the monitor. Refer to the documentation that came with
the monitor for instructions.

Image is not centered.

Cause

Solution

Position may need adjustment.

Press the monitor's Menu button to access the 0SD menu. Select
ImageControl/ Horizontal Position or Vertical Position to adjust
the horizontal or vertical position of the image.

Chapter 6 Troubleshooting without diagnostics



“No Connection, Check Signal Cable” displays on screen.

Cause

Solution

Monitor video cable is disconnected.

Connect the video cable between the monitor and computer.

CAUTION: Ensure that the computer power is off while
connecting the video cable.

“Out of Range” displays on screen.

Cause

Solution

Video resolution and refresh rate are set higher than what the

monitor supports.

Restart the computer and enter Safe Mode. Change the settings to
a supported setting then restart the computer so that the new
settings take effect.

To enter Safe Mode in Windows 7:
1. Restart the computer.

2. Press and hold the F8 key as your computer restarts, before
the Windows logo appears. If the Windows logo appears,
you must restart the computer and try again.

3. Onthe Advanced Boot Options screen, use the arrow keys to
highlight the safe mode option you want, and then press
Enter.

4. Log on to your computer with a user account that has
administrator rights.

When your computer is in safe mode, Safe Mode displays in
the corners of your monitor. To exit safe mode, restart your
computer and let Windows start normally.

To enter Safe Mode in Windows 10:
1. Loginto the computer using an Administrator account.

2. Typemsconfig in the taskbar search box, and then select
msconfig from the list of applications.

3. Click the Boot tab, select Safe boot and then click OK.

High pitched noise coming from inside a flat panel monitor.

Cause

Solution

Brightness and/or contrast settings are too high.

Lower brightness and/or contrast settings.

Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to center the
picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause

Solution

Flat panel monitor’s internal digital conversion circuits may be
unable to correctly interpret the output synchronization of the

graphics card.

1. Select the monitor’s Auto-Adjustment option in the
monitor’s on-screen display menu.

2. Manually synchronize the Clock and Clock Phase on-screen
display functions. To download a SoftPaq that will assist you
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Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or unable to center the
picture on the screen (flat panel monitors using an analog VGA input connection only).

Cause

Solution

with the synchronization, go to the following Web site,
select the appropriate monitor, and download either
SP32347 or SP32202: http://www.hp.com/support

Graphics card is not seated properly or is bad (some models).

1. Reseat the graphics card.

2. Replace the graphics card.

Certain typed symbols do not appear correct.

Cause

Solution

The font you are using does not support that particular symbol.

Use the Character Map to locate and select the appropriate
symbol. You can copy the symbol from the Character Map into a
document.

In Windows 7, click Start, select All Programs, select Accessories,
select System Tools, and then select Character Map.

In Windows 10, type ch in the taskbar search box, and then select
Character Map from the list of applications.

Solving audio problems

If the computer has audio features and you encounter audio problems, see the common causes and solutions

listed in the following table.

Sound cuts in and out.

Cause

Solution

Processor resources are being used by other open applications.

Shut down all open processor-intensive applications.

Sound does not come out of the speaker or headphones.

Cause

Solution

Software volume control is turned down or muted.

Double-click the Speaker icon on the taskbar, then make sure
that Mute is not selected and use the volume slider to adjust the
volume.

Audio is hidden in Computer Setup.

Enable the audio in Computer Setup: Advanced > Built-in Device
Options.

The external speakers are not turned on.

Turn on the external speakers.

The audio device may be connected to the wrong jack.

Ensure that the device is connected to the correct jack on the
computer. The rear audio jack output is the green receptacle. The
speakers should be plugged into the line-out jack and the
headphones should be plugged into the headphone jack.

External speakers plugged into the wrong audio jack on a recently
installed sound card.

See the sound card documentation for proper speaker connection.
The rear audio jack output is the green receptacle.
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Sound does not come out of the speaker or headphones.

Cause

Solution

Headphones or devices connected to the line-out connector mute
the internal speaker.

Turn on and use headphones or external speakers, if connected,
or disconnect headphones or external speakers.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Internal speaker is disabled in Computer Setup.

Enable the internal speaker in Computer Setup. Select Advanced >
Built-in Device Options.

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be listed
in Device Manager. Make sure the correct device is being used.

To access Device Manager in Windows 7, click Start, select Control
Panel, and then select Device Manager.

To access Device Manager in Windows 10, type device
manager in the taskbar search box, and then select Device
Manager from the list of applications.

Some applications can select which audio output device is used.

Make sure the application has selected the correct audio device.

The operating system controls may be set to use a different audio
device as the default output device than what is expected.

Set the operating system to use the correct audio device.

Sound from headphones is not clear or muffled.

Cause

Solution

Headphones are plugged into the rear audio output connector.
The rear audio output connector is for powered audio devices and
is not designed for headphone use.

Plug the headphones into the headphone connector on the front
of the computer.

Computer appears to be locked up while recording audio.

Cause

Solution

The hard disk may be full.

Before recording, make sure there is enough free space on the
hard disk. You can also try recording the audio filein a
compressed format.

Line-in jack is not functioning properly.

Cause

Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the jack or
set the jack to its default value.
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There is no sound or sound volume is too low.

Cause Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be listed
in Device Manager. Make sure the correct device is being used.

To access Device Manager in Windows 7, click Start, select Control
Panel, and then select Device Manager.

To access Device Manager in Windows 10, type device
manager in the taskbar search box, and then select Device
Manager from the list of applications.

Some applications can select which audio output device is used. Make sure the application has selected the correct audio device.

The operating system controls may be set to use a different audio
device as the default output device than what is expected.

Set the operating system to use the correct audio device.

Solving printer problems

If you encounter printer problems, see the documentation that came with the printer and to the common
causes and solutions listed in the following table.

Printer will not print.

Cause

Solution

Printer is not turned on and online.

Turn the printer on and make sure it is online.

The correct printer drivers for the application are not installed.

1. Install the correct printer driver for the application.
2. Try printing using the MS-DOS command:
DIR C:\ > [printer port]

where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.

To run MS-D0OS commands, press the Windows key + r, type cmd
in the Open box, and then click OK.

If you are on a network, you may not have made the connection
to the printer.

Make the proper network connections to the printer.

Printer may have failed.

Run printer self-test.

Printer will not turn on.

Cause

Solution

The cables may not be connected properly.

Reconnect all cables and check the power cord and electrical
outlet.
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Printer prints garbled information.

Cause

Solution

The correct printer driver for the application is not installed.

Install the correct printer driver for the application.

The cables may not be connected properly.

Reconnect all cables.

Printer memory may be overloaded.

Reset the printer by turning it off for one minute, then turn it back
on.

Printer will not print.

Cause

Solution

The printer may be out of paper.

Solving keyboard and mouse problems

If you encounter keyboard or mouse problems, see the documentation that came with the equipment and to
the common causes and solutions listed in the following table.

A wireless keyboard/mouse is not working correctly. Symptoms include lagging mouse movement, jumpy mouse/keyboard, or no

function of mouse/keyboard and external drive.

Cause

Solution

If your computer is equipped with USB 3.0 ports, connected USB
3.0 devices can interfere with the wireless keyboard USB receiver.

Connect the wireless keyboard USB receiver to a USB 2.0 port that
is separated from ports with USB 3.0 devices. If you still
experience interference, you may have to place the connectors
farther apart using an external USB hub.

Keyboard commands and typing are not recognized by the computer.

Cause

Solution

Keyboard connector is not properly connected.

Shut down the computer, reconnect the keyboard to the back of
the computer, and then restart the computer.

Program in use has stopped responding to commands.

Shut down your computer using the mouse and then restart the
computer.

Keyboard needs repairs.

See the Worldwide Limited Warranty for terms and conditions.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep date, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.
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Mouse does not respond to movement or is too slow.

Cause

Solution

Mouse connector is not properly plugged into the back of the
computer.

Shut down the computer using the keyboard.
Windows 7:

1. Press the Ctrl and Esc keys at the same time (or press the
Windows logo key) to display the Start menu.

2. Usethe arrow keys to select Shut Down and then press
Enter.

3.  After the shutdown is complete, plug the mouse connector
into the back of the computer (or the keyboard) and restart.

Windows 10:

1. Press the Ctrl and Esc keys at the same time (or press the
Windows logo key) to display the Start menu.

2. Usethearrow keys to scroll to and select the power icon at
the top right on the menu, and then press Enter.

3.  Usethearrow keys to select Shut Down, and then press
Enter.

4.  After the shutdown is complete, plug the mouse connector
into the back of the computer (or the keyboard) and restart.

Program in use has stopped responding to commands.

Shut down the computer using the keyboard then restart the
computer.

Mouse may need cleaning.

Remove the roller ball cover on the mouse and clean the internal
components.

Mouse may need repair.

See the Worldwide Limited Warranty for terms and conditions.

Computer is in Sleep state.

Press the power button to resume from Sleep state.

CAUTION: When attempting to resume from Sleep state, do not
hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.

Cause

Solution

Mouse roller ball or the rotating encoder shafts that make contact
with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and clean
the internal components with a mouse cleaning kit available from
most computer stores.

Solving Hardware Installation Problems

You may need to reconfigure the computer when you add or remove hardware, such as an additional drive or
expansion card. If you install a plug and play device, Windows automatically recognizes the device and
configures the computer. If you install a non-plug and play device, you must reconfigure the computer after
completing installation of the new hardware. In Windows, use the Add Hardware Wizard and follow the

instructions that appear on the screen.

To open the Add Hardware Wizard, open a Command Prompt and open hdwwiz.exe.
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A WARNING! When the computer is plugged into an AC power source, voltage is always applied to the system
board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to disconnect
the power cord from the wall outlet and allow the internal system components to cool before touching.

Table 6-1 Solving Hardware Installation Problems

A new device is not recognized as part of the system.

Cause

Solution

Device is not seated or connected properly.

Ensure that the device is properly and securely connected and
that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables are
unplugged.

Ensure that all cables are properly and securely connected and
that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on.

Turn off the computer, turn on the external device, then turn on
the computer to integrate the device with the computer system.

When the system advised you of changes to the configuration,
you did not accept them.

Reboot the computer and follow the instructions for accepting the
changes.

A plug and play board may not automatically configure when
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic settings
for the board and choose a basic configuration that does not
cause a resource conflict. You can also use Computer Setup to
reconfigure or disable devices to resolve the resource conflict.

To access Device Manager in Windows 7, click Start, select Control
Panel, and then select Device Manager.

To access Device Manager in Windows 10, type device
manager in the taskbar search box, and then select Device
Manager from the list of applications.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that Device available
is selected for appropriate USB ports under Advanced > Port
Options.

Computer will not start.

Cause

Solution

Wrong memory modules were used in the upgrade or memory
modules were installed in the wrong location.

1.  Review the documentation that came with the system to
determine if you are using the correct memory modules and
to verify the proper installation.

NOTE: DIMM1 or XMM1 must always be installed. DIMM1
must be installed before DIMM2, and DIMM3 must be
installed before DIMMA4.

2.  Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for specific
problems.

3. Ifyoustill cannot resolve the issue, contact Customer
Support.
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Power LED flashes Red three times and then white two times.

Cause Solution

Memory is installed incorrectly or is bad. CAUTION: To avoid damage to the DIMMs or the system board,
you must unplug the computer power cord before attempting to
reseat, install, or remove a DIMM module.

1.  Reseat DIMMs. Power on the system.
2. Replace DIMMs one at a time to isolate the faulty module.

NOTE: DIMM1 or XMM1 must always be installed. DIMM1
must be installed before DIMM2, and DIMM3 must be
installed before DIMM4

3. Replace third-party memory with HP memory.

4. Replace the system board.

Solving Network Problems

Some common causes and solutions for network problems are listed in the following table. These guidelines
do not discuss the process of debugging the network cabling.

Table 6-2 Solving Network Problems

Network driver does not detect network controller.

Cause Solution

Network controller is disabled. 1. Run Computer Setup and enable network controller.

2.  Enable the network controller in the operating system using
Device Manager.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 10, type device
manager in the taskbar search box, and then select Device
Manager from the list of applications.

Incorrect network driver. Check the network controller documentation for the correct driver
or obtain the latest driver from the manufacturer’s Web site.

Network status link light never flashes.

NOTE: The network status light is supposed to flash when there is network activity.

Cause Solution
No active network is detected. Check cabling and network equipment for proper connection.
Network controller is not set up properly. Check for the device status within Windows, such as Device

Manager for driver load and the Network Connections applet
within Windows for link status.

To access Device Manager in Windows 7, click Start, select Control
Panel, and then select Device Manager.
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Table 6-2 Solving Network Problems (continued)
Network status link light never flashes.

NOTE:

The network status light is supposed to flash when there is network activity.

Cause

Solution

To access Device Manager in Windows 10, type device
manager in the taskbar search box, and then select Device
Manager from the list of applications.

Network controller is disabled.

1. Run Computer Setup and enable network controller.

2.  Enable the network controller in the operating system using
Device Manager.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 10, type device
manager in the taskbar search box, and then select Device
Manager from the list of applications.

Network driver is not properly loaded.

Reinstall network drivers.

System cannot autosense the network.

Disable auto-sensing capabilities and force the system into the
correct operating mode.

Diagnostics reports a failure.

Cause

Solution

The cable is not securely connected.

Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely attached
to the correct device.

The cable is attached to the incorrect connector.

Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other end of
the cable.

Ensure that the cable and device at the other end are operating
correctly.

The network controller is defective.

Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.

Cause

Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.

Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer.

Select the Network and Sharing Center icon in the Control Panel
and configure the network controller.

To access Control Panel in Windows 7, click Start, and then select
Control Panel.

To access Control Panel in Windows 10, type control panelin
the taskbar search box, and then select Control Panel from the
list of applications.
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Network controller stopped working when an expansion board was added to the computer.

Cause

Solution

The network controller requires drivers.

Verify that the drivers were not accidentally deleted when the
drivers for a new expansion board were installed.

Network controller stops working without apparent cause.

Cause

Solution

The files containing the network drivers are corrupted.

Reinstall the network drivers using the Recovery Disc Set in
Windows 7.

If necessary, download the softpaq from the web (from a different
computer).

The cable is not securely connected.

Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely attached
to the correct device.

The network controller is defective.

Contact an authorized service provider.

New network card will not boot.

Cause

Solution

New network card may be defective or may not meet industry-
standard specifications.

Install a working, industry-standard NIC, or change the boot
sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.

Cause

Solution

The network controller is not configured properly.

Verify Network Connectivity, that a DHCP Server is present, and
that the Remote System Installation Server contains the NIC
drivers for your NIC.

System setup utility reports unprogrammed EEPROM.

Cause

Solution

Unprogrammed EEPROM.

Contact an authorized service provider.
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Solving memory problems

If you encounter memory problems, some common causes and solutions are listed in the following table.

A CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending on the
Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you must unplug the
computer power cord before attempting to reseat, install, or remove a memory module.

For those systems that support ECC memory, HP does not support mixing ECC and non-ECC memory.
Otherwise, the computer will not boot the operating system.

&7 NOTE:

The memory count will be affected by configurations with the Management Engine (ME) enabled. The

ME uses 8MB of system memory in single channel mode or 16MB of memory in dual-channel mode to
download, decompress, and execute the ME firmware for Out-of-Band (00B), third-party data storage, and

other management functions.

System will not boot or does not function properly after installing additional memory modules.

Cause

Solution

A memory module is not installed in the DIMM1 or XMM1 socket.

Ensure that a memory module is installed in the DIMM1 or XMM1
socket on the system board. This socket must be populated with a
memory module.

Memory module is not the correct type or speed grade for the
system or the new memory module is not seated properly.

Replace module with the correct industry-standard device for the
computer. On some models, ECC and non-ECC memory modules
cannot be mixed.

Out of memory error.

Cause

Solution

You have run out of memory to run the application.

Check the application documentation to determine the memory
requirements.

Memory count during POST is wrong.

Cause

Solution

The memory modules may not be installed correctly.

Check that the memory modules have been installed correctly and
that proper modules are used.

Integrated graphics may use system memory.

No action required.

Insufficient memory error during operation.

Cause

Solution

Too many Terminate and Stay Resident programs (TSRs) are
installed.

Delete any TSRs that you do not need.

You have run out of memory for the application.

Check the memory requirements for the application or add more
memory to the computer.
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Power LED flashes Red five times, once every second, followed by a two second pause, and the computer beeps five times. (Beeps

stop after fifth iteration but LEDs continue flashing.)

Cause

Solution

Memory is installed incorrectly or is bad.

1.  Reseat DIMMs. Power on the system.
2. Replace DIMMs one at a time to isolate the faulty module.
3. Replace third-party memory with HP memory.

4. Replace the system board.

Solving CD-ROM and DVD problems

If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the following table
or to the documentation that came with the optional device.

System will not boot from CD-ROM or DVD drive.

Cause

Solution

The device is attached to a SATA port that has been hidden in the
Computer Setup utility.

Run the Computer Setup utility and ensure Device Available is
selected for the device's SATA port in Advanced > Port Options.

Removable Media Boot is disabled in the Computer Setup utility.

Run the Computer Setup utility and enable booting to removable
media in Advanced > Boot Options.

Network Boot is enabled in Computer Setup.

Run the Computer Setup utility and disable Network Boot in
Advanced > Boot Options.

Non-bootable CD in drive.

Try a bootable CD in the drive.

Boot order not correct.

Run the Computer Setup utility and change boot sequence in
Advanced > Boot Options.

Drive not found (identified).

Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 82 section. If the system still does
not recognize the new device, check to see if the device is listed
within Computer Setup. If it is listed, the probable cause is a driver
problem. If it is not listed, the probable cause is a hardware
problem.

If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > Power-On
Options.

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available is
selected for the device's SATA port in Advanced > Port Options.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in Advanced >
Power-0n Options.
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CD-ROM or DVD devices are not detected or driver is not loaded.

Cause

Solution

Drive is not connected properly or not properly configured.

See the documentation that came with the optional device.

Movie will not play in the DVD drive.

Cause

Solution

Movie may be regionalized for a different country.

See the documentation that came with the DVD drive.

Decoder software is not installed.

Install decoder software.

Damaged media.

Replace media.

Movie rating locked out by parental lock.

Use DVD software to remove parental lock.

Media installed upside down.

Reinstall media.

Cannot eject compact disc (tray-load unit).

Cause

Solution

Disc not properly seated in the drive.

Turn off the computer and insert a thin metal rod into the
emergency eject hole and push firmly. Slowly pull the tray out
from the drive until the tray is fully extended, then remove
the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.

Cause

Solution

Media is corrupt.

Try different media to confirm whether media is valid.

Media has been inserted upside down.

Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to
determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive determine the

type of media being played. If the disc still does not start, read the

other solutions listed for this topic.

CD or DVD disc is dirty.

Clean CD or DVD with a CD cleaning kit, available from most
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive.

1. Use Device Manager to remove or uninstall the device.

To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.

To access Device Manager in Windows 10, type device
manager in the taskbar search box, and then select Device
Manager from the list of applications.

2.  Restart the computer and let Windows detect the CD or DVD
driver.
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Recording or copying CDs is difficult or impossible.

Cause

Solution

Wrong or poor quality media type.

1. Tryusing a slower speed when recording.
2. \Verify that you are using the correct media for the drive.

3. Tryadifferent brand of media. Quality varies widely
between manufacturers.

Solving USB flash drive problems

If you encounter USB flash drive problems, common causes and solutions are listed in the following table.

USB flash drive is not seen as a drive letter in Windows.

Cause

Solution

The drive letter after the last physical drive is not available.

Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).

Cause

Solution

The device is attached to a USB port that has been hidden in
Computer Setup.

Run the Computer Setup utility and enable USB ports in Advanced
> Port Options.

The device was not properly seated before power-up.

Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.

Cause

Solution

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Advanced > Boot Options.

Removable Media Boot is disabled in the Computer Setup utility.

Run the Computer Setup utility and enable booting to removable
media in Advanced > Boot Options. Ensure USB is enabled in
Storage > Boot Order.

The computer boots to DOS after making a bootable flash drive.

Cause

Solution

Flash drive is bootable.

Install the flash drive only after the operating system boots.

Flash drive is defective.

Try a different flash drive.
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Solving front panel component problems

If you encounter problems with devices connected to the front panel, refer to the common causes and

solutions listed in the following table.

A USB device, headphone, or microphone is not recognized by the computer.

Cause

Solution

Device is not properly connected.

1. Turn off the computer.

2. Reconnect the device to the front of the computer and
restart the computer.

The device does not have power.

If the USB device requires AC power, be sure one end is connected
to the device and one end is connected to a live outlet.

The correct device driver is not installed.

1. Install the correct driver for the device.

2. You might need to reboot the computer.

The cable from the device to the computer does not work.

1. If possible, replace the cable.

2.  Restart the computer.

The device is not working.

1.  Replace the device.

2.  Restart the computer.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that the USB ports are
set to Enabled in Security > USB Security.

Solving Internet access problems

If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the common

causes and solutions listed in the following table.

Unable to connect to the Internet.

Cause

Solution

Internet Service Provider (ISP) account is not set up properly.

Verify Internet settings or contact your ISP for assistance.

Web browser is not set up properly.

Verify that the Web browser is installed and set up to work with
your ISP.

Cable/DSL modem is not plugged in.

Plug in cable/DSL modem. You should see a “power” LED light on
the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted due to
bad weather.

Try connecting to the Internet at a later time or contact your ISP.
(If the cable/DSL service is connected, the “cable” LED light on the
front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected.

Connect the CAT5 UTP cable between the cable modem and the
computers’s RJ-45 connector. (If the connection is good, the “PC”
LED light on the front of the cable/DSL modem will be on.)

IP address is not configured properly.

Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of information
that a Web server can store temporarily with the Web browser.
This is useful for having the browser remember some specific
information that the Web server can later retrieve.)

Windows 7:
1.  Select Start > Control Panel.

2.  Click Internet Options.
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Unable to connect to the Internet.

Cause

Solution

3.

In the Browsing history section on the General tab, click the
Delete button.

4. Select the Cookies check box and click the Delete button.
Windows 10:
1. Typecontrol panel inthe taskbar search box, and then
select Control Panel from the list of applications.
2.  Click Internet Options.
3. Inthe Browsing history section, click the Delete button.
4. Select the Cookies and website data check box and click the
Delete button.
Cannot automatically launch Internet programs.
Cause Solution

You must log on to your ISP before some programs will start.

Log on to your ISP and launch the desired program.
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Solving software problems

Most software problems occur as a result of the following:

e  The application was not installed or configured correctly.

e  Thereis insufficient memory available to run the application.

e  Thereis a conflict between applications.

° Be sure that all the needed device drivers have been installed.

e If you have installed an operating system other than the factory-installed operating system, check to be

sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.

Computer will not continue and the HP logo does not display.

Cause

Solution

ROM issue - POST error has occurred.

Observe the beeps and LED lights on the front of the computer.
See POST error messages and diagnostic front panel LEDs and
audible codes on page 94 to determine possible causes.

See the Worldwide Limited Warranty for terms and conditions.

“Illegal Operation has Occurred” error message is displayed.

Cause

Solution

Software being used is not Microsoft-certified for your version of
Windows.

Verify that the software is certified by Microsoft for your version
of Windows (see program packaging for this information).

Configuration files are corrupt.

If possible, save all data, close all programs, and restart the
computer.
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7 POST error messages and diagnostic front
panel LEDs and audible codes

This appendix lists the error codes, error messages, and the various indicator light and audible sequences
that you may encounter during Power-0n Self-Test (POST) or computer restart, the probable source of the
problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during POST, such as memory count and non-
error text messages. If a POST error occurs, the screen will display the error message. To manually switch to
the POST Messages Enabled mode during POST, press any key (except F10, F11, or F12). The default mode is
POST Message Disabled.

The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.

Quick Boot is a fast startup process that does not run all of the system level tests, such as the memory test.
Full Boot runs all of the ROM-based system tests and takes longer to complete.

Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish the
schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.

r.%’ NOTE: For more information on Computer Setup, see Computer Setup (F10) Utility on page 52.

POST numeric codes and text messages

This section covers those POST errors that have numeric codes associated with them. The section also
includes some text messages that may be encountered during POST.

[%9 NOTE: The computer will beep once after a POST text message is displayed on the screen.

Control panel message Description Recommended action
002-0ption ROM Checksum Error System ROM or expansion board option ROM 1. Verify the correct ROM.
checksum.

2.  Flash the ROM if needed.

3. If an expansion board was recently added,
remove it to see if the problem remains.

4. Clear CMOS. (See Password security and
resetting CMOS on page 101.)

5. If the message disappears, there may be a
problem with the expansion card.

6. Replace the system board.

003-System Board Failure DMA or timers. 1.  Clear CMOS. (See Password security and
resetting CMOS on page 101.)

2.  Remove expansion boards.

3. Replace the system board.

005-Real-Time Clock Power Loss Invalid time or date in configuration memory. Reset the date and time under Control Panel
(Computer Setup can also be used). If the
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Control panel message

Description

Recommended action

RTC (real-time clock) battery may need to
be replaced.

problem persists, replace the RTC battery. See
the Removal and Replacement section for
instructions on installing a new battery.

008—-Microcode Patch Error

Processor is not supported by the BIOS.

1. Upgrade BIOS to proper version.

2. Change the processor.

009-PMM Allocation Error during MEBx
Download

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1.  Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.  If the memory configuration was recently
changed, unplug the computer, restore
the original memory configuration, and
reboot the computer.

4. If the error persists, replace the system
board.

100-Front Audio Not Connected

Front audio cable has been detached or
unseated from system board.

Reconnect or replace front audio cable.

00A-Product Information Not Valid

The product information programmed into the
system board is missing or invalid.

Use Computer Setup to update this information.

00B-MEBx Module did not checksum correctly

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1.  Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.  If the memory configuration was recently
changed, unplug the power cord, restore
the original memory configuration, and
reboot the computer.

4. If the error persists, replace the system
board.

00C-PMM Deallocation Error during MEBx
Cleanup

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.  If the memory configuration was recently
changed, unplug the power cord, restore
the original memory configuration, and
reboot the computer.

4.  If the error persists, replace the system
board.

00D-Setup Error during MEBx Execution

MEBx selection or exit resulted in a setup
failure.

1. Reboot the computer.

2. Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.  If the memory configuration was recently
changed, unplug the power cord, restore
the original memory configuration, and
reboot the computer.
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Control panel message

Description

Recommended action

4.  If the error persists, replace the system
board.

00E-Inventory Error during MEBx Execution

BIOS information passed to the MEBx resulted
in a failure.

1.  Reboot the computer.

2. If the error persists, update to the latest
BIOS version.

3. If the error still persists, replace the
system board.

00F-Interface Error during MEBx Execution

MEBx operation experienced a hardware error
during communication with the ME.

1.  Reboot the computer.

2. If the error persists, update to the latest
BIOS version.

3. If the error still persists, replace the
system board.

2E1-MemorySize Error

Memory amount has changed since the last
boot (memory added or removed).

The system memory size is different from the
last startup. The most common reason is the
removal of memory from the system board.
Press the F1 key to save the memory changes.
If this message persists, verify that the
memory modules are installed correctly.

2E2-Memory Error

Memory module configuration failed during
boot up.

1. Ensure memory modules are correctly
installed.

2. Verify proper memory module type.

3.  Remove and replace the identified faulty
memory module(s).

4. |If the error persists after replacing
memory modules, replace the system
board.

2E3-Incompatible Memory Module in Memory
Socket(s) X, X, ...

A memory module in memory socket identified
in the error message is missing critical SPD

information, or is incompatible with the chipset.

1. Verify proper memory module type.
2. Try another memory socket.

3. Replace with a supported module.

2E4-DIMM Configuration Warning

The current memory configuration is not
optimized.

Rearrange the DIMMs so that each channel has
the same amount of memory.

2E5-ECC Memory Module Detected on
Unsupported Platform

Recently added memory module(s) support ECC
memory error correction.

1.  If additional memory was recently added,
remove it to see if the problem remains.

2. Check product documentation for
memory support information.

2E6—-Memory Not Configured Correctly for
Proper MEBx Execution

DIMM1 is not installed.

Make sure there is a memory module in the
DIMM1 socket and that it is properly seated.

300—Configuration Change Warning

The storage device configuration will be
updated as shown.

Not applicable

301-Hard Disk 1: SMART Hard Drive Detects
Imminent Failure

Hard drive is about to fail. (Some hard drives
have a hard drive firmware patch that will fix an
erroneous error message.)

1. Determine if hard drive is giving correct
error message. Run the Drive Protection
System test under using F2 Diagnostics
when booting the computer.

2. Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)
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Control panel message

Description

Recommended action

Back up contents and replace hard drive.

302-Hard Disk 2: SMART Hard Drive Detects
Imminent Failure

Hard drive is about to fail. (Some hard drives
have a hard drive firmware patch that will fix an
erroneous error message.)

Determine if hard drive is giving correct
error message. Run the Drive Protection
System test under using F2 Diagnostics
when booting the computer.

Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

Back up contents and replace hard drive.

309 - 30C: Hard Disk 3—6: SMART Hard Drive
Detects Imminent Failure

Hard drive is about to fail. (Some hard drives
have a hard drive firmware patch that will fix an
erroneous error message.)

3.

Determine if hard drive is giving correct
error message. Run the Drive Protection
System test under using F2 Diagnostics
when booting the computer.

Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

Back up contents and replace hard drive.

3F0-Boot Device Not Found

Boot device not found.

Insert boot device or load operating system.

3F1-Hard Disk 1 Error Hard disk 1 error. 1.  Check and/or replace cables.
2.  Clear CMOS. (See Password security and
resetting CMOS on page 101.)
3.  Replace the hard disk drive.
3F2-Hard Disk 2 Error Hard disk 2 error. 1. Check and/or replace cables.
2. Clear CMOS. (See Password security and
resetting CMOS on page 101.)
3.  Replace the hard disk drive.
400-Serial Port A Address Conflict Detected Both external and internal serial ports are 1. Remove any serial port expansion cards.
assigned to the same resources.
2.  Clear CMOS. (See Password security and
resetting CMOS on page 101.)
3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.
401-Serial Port B Address Conflict Detected Both external and internal serial ports are 1. Remove any serial port expansion cards.
assigned to the same resources.
2.  Clear CMOS. (See Password security and
resetting CMOS on page 101.)
3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.
402-Serial Port C Address Conflict Detected Both external and internal serial ports are 1. Remove any serial port expansion cards.
assigned to the same resources.
2.  Clear CMOS. (See Password security and
resetting CMOS on page 101.)
3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.
403-Serial Port D Address Conflict Detected Both external and internal serial ports are 1. Remove any serial port expansion cards.
assigned to the same resources.
2. Clear CMOS. (See Password security and

resetting CMOS on page 101.)
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Control panel message

Description

Recommended action

3. Reconfigure card resources and/or run
Computer Setup or Windows utilities.

419-0ut of Memory Space for Option ROMs

Recently added PCl expansion card contains an
option ROM too large to download during POST.

A If aPCl expansion card was recently
added, remove it to see if the problem
remains.

41A-Front USB1/USB2 Not Connected

Front USB cable has been detached or unseated
from system board.

Reconnect or replace front USB cable.

41B-Device in PCl Express Slot Failed To
Initialize

There is an incompatibility or problem with a
PCle device and the system or PCle link could
not be configured to a valid bus width or speed.

Try rebooting the system. If the error reoccurs,
the device may not work with this system

43A-USB Type-C I12C Not Connected

Cable is required between I2C on card and USB-
Con the system board.

Install cable between I2C on card and USB-C on
the system board.

43B-More Than One USB type-C Cards Are
Installed

More than one USB type-C card is installed.

Remove USB type-C card so only one is
installed.

500-BIOS Recovery

A system BIOS recovery has occurred.

Not applicable.

60x-HP Battery Alert

The system has detected the storage capacity
of the battery stated below to be very low.

For optimal performance, replace the battery.

70x-Wireless Mode Not Supported

The system has detected a wireless module
installed in the system that is not supported
and has been disabled.

Replace with a supported module.

800-Keyboard Error

Keyboard failure.

1. Reconnect keyboard with computer
turned off.

2. Check connector for bent or missing pins.

3.  Ensure that none of the keys are
depressed.

4. Replace keyboard.

801-Keyboard or System Unit Error

Keyboard failure.

1. Reconnect the keyboard with computer
turned off.

2.  Ensure that none of the keys are
depressed.

3. Replace the keyboard.

4. Replace the system board.

900-CPU Fan Not Detected

CPU fan is not connected or may have
malfunctioned.

1.  Reseat CPU fan.
2. Reseat fan cable.

3. Replace CPU fan.

901-Chassis, Rear Chassis, or Front Chassis Fan
not Detected

Chassis, rear chassis, or front chassis fan is not
connected or may have malfunctioned.

1.  Reseat chassis, rear chassis, or front
chassis fan.

2. Reseat fan cable.

3. Replace chassis, rear chassis, or front
chassis fan.

904-SATA Cabling Error

One or more SATA devices are improperly
attached. For optimal performance, the SATA 0
and SATA 1 ports should be used for hard drives
before other ports.

Ensure SATA connectors are used in ascending
order. For one device, use SATA 0. For two
devices, use SATA 0 and SATA 1. For three
devices, use SATA 0, SATA 1, and SATA 2.
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Control panel message Description Recommended action

910-Filter Warning Airflow filter is dirty. Replace the airflow filter.

90B-Fan Failure The system has detected that a cooling fan is 1. Reseat fan.

not operating correctly.
2. Reseat fan cable.

3. Replace fan.

90D-System Temperature Thermal shutdown occurred. The system BIOS Make sure system has proper airflow.
has detected your machine was previously shut
down to avoid overheating. Overheating may
occur if the cooling vents are blocked or the
operating temperature exceeds the system
specifications. The machine should return to
normal operation once the situation is resolved.

90E-Power Supply Fan Not detected Power supply fan is not connected or may have 1.  Reseat power supply fan.

malfunctioned.
2. Reseat fan cable.

3. Replace power supply fan.

Interpreting system validation diagnostic front panel LEDs and
audible codes

During the system validation phase that occurs at system startup, the BIOS validates the functionality of the
following subsystems and conditions:

e  ACadapter

e  System board power

e  Processor failure

e  BIOS corruption

e  Memory failure

e  Graphics failure

e  System board failure

e  BIOS authentication failure

If an error is detected, specific patterns of long and short blinks, accompanied by long and short beeps (where
applicable) are used to identify the error. These patterns will make up a two part code:

e  Major —the category of the error

e  Minor—the specific error within the category

B NOTE: Single beep/blink codes are not used.

Number of long beeps/blinks Error category
1 Not used

2 BIOS

3 Hardware
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Number of long beeps/blinks Error category

4 Thermal

5 System board

Patterns of blink/beep codes are determined by using the following parameters:

e 1 second pause occurs after the last major blink.

° 2 second pause occurs after the last minor blink.

e  Beep error code sequences occur for the first 5 iterations of the pattern and then stop.

e  Blink error code sequences continue until the computer is unplugged or the power button is pressed.

[%’/r NOTE: Not all diagnostic lights and audible codes are available on all models.

The red LED blinks to represent the major error category (long blinks). The white LED blinks to represent the
minor error category (short blinks). For example, ‘3.5’ indicates 3 long red blinks and 5 short white blinks to
communicate the processor is not detected.

Category Major/minor code Description

BIOS 2.2 The main area (DXE) of BIOS has become corrupted and there is no recovery
binary image available.

2.3 The embedded controller policy requires the user to enter a key sequence.
2.4 The embedded controller is checking or recovering the boot block.
Hardware 3.2 The embedded controller has timed out waiting for BIOS to return from

memory initialization.

3.3 The embedded controller has timed out waiting for BIOS to return from
graphics initialization.

3.4 The system board displays a power failure (crowbar).*
3.5 The processor is not detected.*
3.6 The processor does not support an enabled feature.
Thermal 4.2 A processor over temperature condition has been detected.*
4.3 An ambient temperature over temperature condition has been detected.
4.4 An MXM over temperature condition has been detected.
System board 5.2 The embedded controller cannot find valid firmware.
5.3 The embedded controller has timed out waiting for the BIOS.
5.4 The embedded controller has timed out waiting for BIOS to return from

system board initialization.

5.5 The embedded controller rebooted the system after a possible lockup
condition had been detected through the use of a System Health Timer,
Automated System Recovery Timer, or other mechanism.

* Indicates hardware triggered event; all other events are controlled by the BIOS.
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8 Password security and resetting CM0S

This computer supports security password features, which can be established through the Computer Setup
Utilities menu.

This computer supports two security password features that are established through the Computer Setup
Utilities menu: setup password and power-on password. When you establish only a setup password, any user
can access all the information on the computer except Computer Setup. When you establish only a power-on
password, the power-on password is required to access Computer Setup and any other information on the
computer. When you establish both passwords, only the setup password will give you access to Computer
Setup.

When both passwords are set, the setup password can also be used in place of the power-on password as an
override to log in to the computer. This is a useful feature for a network administrator.

If you forget the password for the computer, you can clear that password so you can gain access to the
information on the computer by resetting the password jumper.

/\ CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to back up the
computer CMOS settings before resetting them in case they are needed later. Back up is easily done through
Computer Setup. See Computer Setup (F10) Utility on page 52 for information on backing up the CM0OS
settings.

Resetting the password jumper

A CAUTION: If you enable the stringent security feature in Computer Setup and you forget the setup password
or the power-on password, the computer is inaccessible and can no longer be used.

Enabling the stringent password disables the ability to reset the password by moving the jumper on the
system board.

If you lose or forget the password, the system board must be replaced. This scenario is not covered under
warranty.

To prevent the computer from becoming permanently unusable, record your configured setup password or
power-on password in a safe place away from your computer. Without these passwords, the computer cannot
be unlocked.

To disable the power-on or setup password features, or to clear the power-on or setup passwords, complete
the following steps:
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1.  Shut down the operating system properly, then turn off the computer and any external devices, and
disconnect the power cord from the power outlet.

2.  With the power cord disconnected, press the power button again to drain the system of any residual
power.

A WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to
disconnect the power cord from the wall outlet, and allow the internal system components to cool
before touching.

A CAUTION: When the computer is plugged in, the power supply always has voltage applied to the
system board even when the unit is turned off. Failure to disconnect the power cord can result in
damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object. See the Safety & Regulatory Information guide for more information.

3. Remove the access panel.

4. Locate the header and jumper.

[1?? NOTE: The password jumper is green so that it can be easily identified. For assistance locating the
password jumper and other system board components, see the system board components image at
System board callouts on page 50.

Remove the jumper from pins 1 and 2.
Place the jumper on either pin 1 or 2, but not both, so that it does not get lost.

Replace the access panel and reconnect the external equipment.

e

Plug in the computer and turn on power. Allow the operating system to start. This clears the current
passwords and disables the password features.

9. Shut down the computer, unplug the power, and disconnect the external equipment.
10. Remove the access panel.

11. Place the jumper on pins 1 and 2.

12. Replace the access panel.

13. Reconnect the external equipment and plug in the computer.

Changing a Setup or Power-0n password

To change the power-on or setup password, complete the following steps:
1. Turnon or restart the computer.
To change the Setup password, go to step 2.
To change the Power-on password, go to step 3.
2. Tochange the Setup password, as soon as the computer turns on:
- Press the Esc key while “Press the ESC key for Startup Menu” message is displayed.
- Press the F10 key to enter Computer Setup.
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3.  When the key icon appears, type your current password, a slash (/) or alternate delimiter character, your
new password, another slash (/) or alternate delimiter character, and your new password again as
shown:

current password/new password/new password

[%”r NOTE: Type the new password carefully since the characters do not appear on the screen.

4. Press Enter.

The new password will take effect the next time the computer is restarted.

Deleting a Setup or Power-On password

To delete the power-on or setup password, complete the following steps:
1. Turnon or restart the computer.
To delete the Setup password, go to step 2.
To delete the Power-on password, go to step 3.
2. Todelete the Setup password, as soon as the computer turns on:
- Press the Esc key while “Press the ESC key for Startup Menu” message is displayed.
- Press the F10 key to enter Computer Setup.

3.  When the key icon appears, type your current password, a slash (/) or alternate delimiter character, your
new password, another slash (/) or alternate delimiter character, and your new password again as
shown:

current password/

4. Press Enter.

Clearing and resetting the CM0S

The computer’s configuration memory (CMOS) stores information about the computer’s configuration.
The CMOS button resets CMOS but does not clear the power-on and setup passwords.
1. Turn off the computer and any external devices, and disconnect the power cord from the power outlet.

2. Disconnect the keyboard, monitor, and any other external equipment connected to the computer.

A WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be sure to
disconnect the power cord from the wall outlet, and allow the internal system components to cool
before touching.

A CAUTION: When the computer is plugged in, the power supply always has voltage applied to the
system board even when the unit is turned off. Failure to disconnect the power cord can result in
damage to the system.

Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object. See the Safety & Regulatory Information guide for more information.

3. Remove the access panel.
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A CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to back
up the computer CMOS settings before resetting them in case they are needed later. Back up is easily
done through Computer Setup. See Computer Setup (F10) Utility on page 52 for information on backing
up the CMOS settings.

4. Locate, press, and hold the CMOS button in for five seconds.

l% NOTE: Make sure you have disconnected the AC power cord from the wall outlet. The CMOS button will
not clear CMOS if the power cord is connected.

l% NOTE: For assistance locating the CMOS button and other system board components, see the system
board components image at System board callouts on page 50.

5. Replace the access panel.
6. Reconnect the external devices.

7 Plug in the computer and turn on power.

[%9 NOTE: You will receive POST error messages after clearing CMOS and rebooting advising you that
configuration changes have occurred. Use Computer Setup to reset any special system setups along with
the date and time.

For instructions on Computer Setup, see Computer Setup (F10) Utility on page 52.
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9 HPPCHardware Diagnostics

To help troubleshoot and diagnose failures, use the UEFI-based hardware diagnostic solution that HP includes
on all products. This tool can even be used if the computer will not boot to the operating system.

Why run HP PC Hardware Diagnostics

The HP PC Hardware Diagnostic tools simplify the process of diagnosing hardware issues and expedite the
support process when issues are found. The tools save time by pinpointing the component that needs to be
replaced.

e Isolate true hardware failures: The diagnostics run outside of the operating system so they effectively
isolate hardware failures from issues that may be caused by the operating system or other software
components.

o  Failure ID: When a failure is detected that requires hardware replacement, a 24-digit Failure ID is
generated. This ID can then be provided to the call agent, who will either schedule support or provide
replacement parts.

How to access and run HP PC Hardware Diagnostics

You can run the diagnostics from one of three places, depending on your preference and the health of the
computer.

1. Turn on the computer and press Esc repeatedly until the BIOS Boot Menu appears.
2. Press F2 or select Diagnostics (F2).
Pressing F2 signals the system to search for the diagnostics in the following locations:

a. Aconnected USB drive (to download the diagnostics tools to a USB drive, see the instructions in
Downloading HP PC Hardware Diagnostics (UEFI) to a USB device on page 105)

b. The hard disk drive

c.  Acoreset of diagnostics in the BIOS (for memory and hard disk drive) that are accessible only if the
USB or hard disk drive versions are not detected

Downloading HP PC Hardware Diagnostics (UEFI) to a USB device

[:?’”r NOTE: Instructions for downloading HP PC Hardware Diagnostics (UEFI) are provided in English only.

There are two options to download HP PC Hardward Diagnostics to USB device.
Option 1: HP PC Diagnostics homepage—Provides access to the latest UEFI version

1. Go to http://www.hp.com/go/techcenter/pcdiags.

2. Click the UEFI Dowload link, and then select Run.

Option 2: Support and Drivers pages—Provides downloads for a specific product for earlier and later
versions.
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1. Go to http://www.hp.com.

2. Point to Support, located at the top of the page, and then click Download Drivers.
3. Inthe text box, enter the product name, and then click Go.
—or-
Click Find Now to let HP automatically detect your product.
4. Select your computer model, and then select your operating system.
5. Inthe Diagnostic section, click HP UEFI Support Environment.

6. Click Download, and then select Run.

106 Chapter9 HP PCHardware Diagnostics


http://www.hp.com

10 System backup and recovery

Backing up, restoring, and recovering in Windows 10

This section provides information about the following processes. The information in the section is standard
procedure for most products.

Creating recovery media and backups

Restoring and recovering your system

For additional information, refer to Help and Support.

A Typehelpinthe taskbar search box, and then select Help and Support.

Creating recovery media and backups

The following methods of creating recovery media and backups are available on select products only. Choose
the available method according to your computer model.

Use HP Recovery Manager to create HP Recovery media after you successfully set up the computer. This
step creates a backup of the HP Recovery partition on the computer. The backup can be used to reinstall
the original operating system in cases where the hard drive is corrupted or has been replaced. For
information on creating recovery media, see Creating HP Recovery media (select products only)

on page 107. For information on the recovery options that are available using the recovery media, see
What you need to know before you get started on page 109.

Use Windows tools to create system restore points and create backups of personal information.

For more information, see Using Windows tools on page 109.

[% NOTE: |If storageis 32 GB or less, Microsoft System Restore is disabled by default.

Creating HP Recovery media (select products only)

If possible, check for the presence of the Recovery partition and the Windows partition. From the Start menu,
select File Explorer.

If your computer does not list the Windows partition and the Recovery partition, you can obtain recovery
media for your system from support. See the Worldwide Telephone Numbers booklet included with the
computer. You can also find contact information on the HP website. Go to http://www.hp.com/support,
select your country or region, and follow the on-screen instructions.

You can use Windows tools to create system restore points and create backups of personal information,
see Using Windows tools on page 109.

If your computer does list the Recovery partition and the Windows partition, you can use HP Recovery
Manager to create recovery media after you successfully set up the computer. HP Recovery media can be
used to perform system recovery if the hard drive becomes corrupted. System recovery reinstalls the
original operating system and software programs that were installed at the factory and then configures
the settings for the programs. HP Recovery media can also be used to customize the system or restore
the factory image if you replace the hard drive.
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o Only one set of recovery media can be created. Handle these recovery tools carefully, and keep
them in a safe place.

o HP Recovery Manager examines the computer and determines the required storage capacity for
the media that will be required.

o To create recovery discs, your computer must have an optical drive with DVD writer capability, and
you must use only high-quality blank DVD-R, DVD+R, DVD-R DL, or DVD+R DL discs. Do not use
rewritable discs such as CD+RW, DVD+RW, double-layer DVD+RW, or BD-RE (rewritable Blu-ray)
discs; they are not compatible with HP Recovery Manager software. Or, instead, you can use a high-
quality blank USB flash drive.

o If your computer does not include an integrated optical drive with DVD writer capability, but you
would like to create DVD recovery media, you can use an external optical drive (purchased
separately) to create recovery discs. If you use an external optical drive, it must be connected
directly to a USB port on the computer; the drive cannot be connected to a USB port on an external
device, such as a USB hub. If you cannot create DVD media yourself, you can obtain recovery discs
for your computer from HP. See the Worldwide Telephone Numbers booklet included with the
computer. You can also find contact information on the HP website. Go to http://www.hp.com/
support, select your country or region, and follow the on-screen instructions.

o Besure that the computer is connected to AC power before you begin creating the recovery media.
o The creation process can take an hour or more. Do not interrupt the creation process.

o If necessary, you can exit the program before you have finished creating all of the recovery DVDs.
HP Recovery Manager will finish burning the current DVD. The next time you start HP Recovery
Manager, you will be prompted to continue.

To create HP Recovery media:
1. Type recovery in the taskbar search box, and then select HP Recovery Manager.
2. Select Create recovery media, and then follow the on-screen instructions.

If you ever need to recover the system, see Recovering using HP Recovery Manager on page 109.
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Using Windows tools

You can create recovery media, system restore points, and backups of personal information using Windows
tools.

B NOTE: If storage is 32 GB or less, Microsoft System Restore is disabled by default.

For more information and steps, see Help and Support.

A Typehelp inthe taskbar search box, and then select Help and Support.

Restore and recovery

There are several options for recovering your system. Choose the method that best matches your situation
and level of expertise:

Fﬁ" IMPORTANT: Not all methods are available on all products.

e  Windows offers several options for restoring from backup, refreshing the computer, and resetting the
computer to its original state. For more information see Help and Support.

A Typehelpinthe taskbar search box, and then select Help and Support.

e If you need to correct a problem with a preinstalled application or driver, use the Reinstall drivers and/
or applications option (select products only) of HP Recovery Manager to reinstall the individual
application or driver.

A Type recovery in the taskbar search box, select HP Recovery Manager, select Reinstall drivers
and/or applications, and then follow the on-screen instructions.

e |f you want to recover the Windows partition to original factory content, you can choose the System
Recovery option from the HP Recovery partition (select products only) or use the HP Recovery media.
For more information, see Recovering using HP Recovery Manager on page 109. If you have not already
created recovery media, see Creating HP Recovery media (select products only) on page 107.

e  Onselect products, if you want to recover the computer's original factory partition and content, or if you
have replaced the hard drive, you can use the Factory Reset option of HP Recovery media. For more
information, see Recovering using HP Recovery Manager on page 109.

e  Onselect products, if you want to remove the recovery partition to reclaim hard drive space, HP
Recovery Manager offers the Remove Recovery Partition option.

For more information, see Removing the HP Recovery partition (select products only) on page 111.

Recovering using HP Recovery Manager

HP Recovery Manager software allows you to recover the computer to its original factory state by using the
HP Recovery media that you either created or that you obtained from HP, or by using the HP Recovery
partition (select products only). If you have not already created recovery media, see Creating HP Recovery
media (select products only) on page 107.

What you need to know before you get started

e  HP Recovery Manager recovers only software that was installed at the factory. For software not provided
with this computer, you must either download the software from the manufacturer's website or reinstall
the software from the media provided by the manufacturer.
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M IMPORTANT: Recovery through HP Recovery Manager should be used as a final attempt to correct
computer issues.

e  HP Recovery media must be used if the computer hard drive fails. If you have not already created
recovery media, see Creating HP Recovery media (select products only) on page 107.

e  Touse the Factory Reset option (select products only), you must use HP Recovery media. If you have not
already created recovery media, see Creating HP Recovery media (select products only) on page 107.

e |f your computer does not allow the creation of HP Recovery media or if the HP Recovery media does not
work, you can obtain recovery media for your system from support. See the Worldwide Telephone
Numbers booklet included with the computer. You can also find contact information from the HP
website. Go to http://www.hp.com/support, select your country or region, and follow the on-screen
instructions.

M" IMPORTANT: HP Recovery Manager does not automatically provide backups of your personal data. Before
beginning recovery, back up any personal data you want to retain.

Using HP Recovery media, you can choose from one of the following recovery options:

[%/’”]’9 NOTE: Only the options available for your computer display when you start the recovery process.

e  System Recovery—Reinstalls the original operating system, and then configures the settings for the
programs that were installed at the factory.

e  Factory Reset—Restores the computer to its original factory state by deleting all information from the
hard drive and re-creating the partitions. Then it reinstalls the operating system and the software that
was installed at the factory.

The HP Recovery partition (select products only) allows System Recovery only.

Using the HP Recovery partition (select products only)

The HP Recovery partition allows you to perform a system recovery without the need for recovery discs or a
recovery USB flash drive. This type of recovery can be used only if the hard drive is still working.

To start HP Recovery Manager from the HP Recovery partition:

1. Type recovery inthe taskbar search box, select Recovery Manager, and then select HP Recovery
Environment.

- Or -
Press f11 while the computer boots, or press and hold f11 as you press the power button.
2. Select Troubleshoot from the boot options menu.

3. Select Recovery Manager, and then follow the on-screen instructions.

Using HP Recovery media to recover

You can use HP Recovery media to recover the original system. This method can be used if your system does
not have an HP Recovery partition or if the hard drive is not working properly.

1. If possible, back up all personal files.

2. Insert the HP Recovery media, and then restart the computer.

[:?'”f NOTE: If the computer does not automatically restart in HP Recovery Manager, change the computer
boot order. See Changing the computer boot order on page 111.

3. Follow the on-screen instructions.
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Changing the computer boot order

If your computer does not restart in HP Recovery Manager, you can change the computer boot order, which is
the order of devices listed in BIOS where the computer looks for startup information. You can change the
selection to an optical drive or a USB flash drive.

To change the boot order:
1. Insert the HP Recovery media.
2.  Access BIOS.
Restart the computer, quickly press esc, and then press f9 for boot options.
3. Select the optical drive or USB flash drive from which you want to boot.

4. Follow the on-screen instructions.

Removing the HP Recovery partition (select products only)

HP Recovery Manager software allows you to remove the HP Recovery partition to free up hard drive space.

E‘% IMPORTANT: After you remove the HP Recovery partition, you will not be able to perform System Recovery
or create HP recovery media from the HP Recovery partition. So before you remove the Recovery partition,
create HP Recovery media; see Creating HP Recovery media (select products only) on page 107.

[i;’af‘ NOTE: The Remove Recovery Partition option is only available on products that support this function.

Follow these steps to remove the HP Recovery partition:
1. Type recovery inthe taskbar search box, and then select HP Recovery Manager.

2. Select Remove Recovery Partition, and then follow the on-screen instructions.

Backing up, restoring, and recovering in Windows 7

Your computer includes tools provided by HP and Windows to help you safeguard your information
and retrieve it if you ever need to. These tools will help you return your computer to a proper working state or
even back to the original factory state, all with simple steps.

This section provides information about the following processes:
e  (reating recovery media and backups

e  Restoring and recovering your system

E?'”f NOTE: This section describes an overview of backing up, restoring, and recovering options. For more details
about the Windows Backup and Restore tools provided, see Help and Support. To access Help and Support,
select Start > Help and Support.

Recovery after a system failure is only as good as your most recent backup.
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1.  After you successfully set up the computer, create recovery media. This media can be used to reinstall
the original operating system in cases where the hard drive is corrupted or has been replaced. See
Creating recovery media on page 112.

2. Asyou add hardware and software programs, create system restore points. A system restore pointis a
snapshot of certain hard drive contents saved by Windows System Restore at a specific time. A system
restore point contains information that Windows uses, such as registry settings. Windows creates a
system restore point for you automatically during a Windows update and during other system
maintenance (such as a software update, security scanning, or system diagnostics). You can also
manually create a system restore point at any time. For more information and steps for creating specific
system restore points, see Help and Support. To access Help and Support, select Start > Help and
Support.

3. Asyou add photos, video, music, and other personal files, create a backup of your personal information.
If files are accidentally deleted from the hard drive and they can no longer be restored from the Recycle
Bin, or if files become corrupted, you can restore the files that you backed up. In case of system failure,
you can use the backup files to restore the contents of your computer. See Backing up your information
on page 114.

[%”f NOTE: HP recommends that you print the recovery procedures and save them for later use, in case of
system instability.

Creating recovery media

After you successfully set up the computer, create recovery media. The media can be used to reinstall the
original operating system in cases where the hard drive is corrupted or has been replaced.

There are two types of recovery media. To determine which steps to follow for your computer:
1.  Click the Start button.
2. Click All Programs.

e If Security and Protection is listed, continue with the steps in Creating recovery media using HP
Recovery Manager (select models only) on page 112.

o If Productivity and Tools is listed, continue with the steps in Creating recovery discs with HP
Recovery Disc Creator (select models only) on page 113.

Creating recovery media using HP Recovery Manager (select models only)

e  Tocreate recovery discs, your computer must have a DVD writer. Use DVD+R or DVD-R discs (purchased
separately). The discs you use will depend on the type of optical drive you are using.

Ef NOTE: DVD+R DL, DVD-R DL, or DVD+RW disc are not supported.

e  You have the option of creating a recovery USB flash drive instead, using a high-quality USB drive.

e If you are creating recovery discs, be sure to use high-quality discs. It is normal for the system to reject
defective discs. You will be prompted to insert a new blank disc to try again.

e  The number of discs in the recovery-disc set depends on your computer model (typically 3 to 6 DVDs).
The Recovery Media Creation program tells you the specific number of blank discs needed to make the
set. If you are using a USB flash drive, the program will tell you the size of the drive required to store all
the data (minimum of 8 GB).

A,

[ NOTE: The process of creating recovery media is lengthy. You can quit the process at any time. The
next time you initiate the process, it resumes where it left off.
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[%f NOTE: Do not use media cards for creating recovery media. The system may not be able to boot up from a
media card and you may not be able to run system recovery.

To create recovery discs:
1. Close all open programs.

2.  Click the Start button, click All Programs, click Security and Protection, click Recovery Manager, and
then click HP Recovery Media Creation. If prompted, click Yes to allow the program to continue.

3. Click Create recovery media using blank DVD(s), and then click Next.

4. Follow the on-screen instructions. Label each disc after you make it (for example, Recovery 1, Recovery
2), and then store the discs in a secure place.

To create a recovery USB flash drive:

Ej?)y NOTE: You must use a USB flash drive with a capacity of at least 8 GB.
[:;’/f’ NOTE: Recovery Media Creation formats the USB flash drive, deleting any files on it.

1. Close all open programs.
2. Insert the USB flash drive into a USB port on the computer.

3.  Click the Start button, click All Programs, click Security and Protection, click Recovery Manager, and
then click Recovery Media Creation.

4. Click Create recovery media with a USB flash drive, and then click Next.

5. Select the USB flash drive from the list of media. The program will let you know how much storage is
required to create the recovery drive. If the USB flash drive does not have enough storage capacity, it will
appear grayed out, and you must replace it with a larger USB flash drive. Click Next.

6. Follow the on-screen instructions. When the process is complete, label the USB flash drive and store it in
a secure place.

Creating recovery discs with HP Recovery Disc Creator (select models only)

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery discs on
select models. After you successfully set up the computer, you can create recovery discs using HP Recovery
Disc Creator. The recovery discs allow you to reinstall your original operating system as well as select drivers
and applications if the hard drive becomes corrupted. HP Recovery Disc Creator creates two kinds of recovery
discs:

e  Windows 7 operating system DVD—Installs the operating system without additional drivers or
applications.

e  Driver Recovery DVD—Installs specific drivers and applications only, in the same way that the HP
Software Setup utility installs drivers and applications.

To create recovery discs, your computer must have a DVD writer. Use any of the following types of discs
(purchased separately): DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend on
the type of optical drive you are using.

Creating recovery discs

Ej?)y NOTE: The Windows 7 operating system DVD can be created only once. The option to create that media will
not be available after you create a Windows DVD.

To create the Windows DVD:
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1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.
Select Windows disk.

From the drop-down menu, select the drive for burning the recovery media.

Lol

Click the Create button to start the burning process. Label the disc after you create it, and store itin a
secure place.

After the Windows 7 operating system DVD has been created, create the Driver Recovery DVD:
1.  Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2.  Select Driver disk.

3.  From the drop-down menu, select the drive for burning the recovery media.

4

Click the Create button to start the burning process. Label the disc after you create it, and store itin a
secure place.

Backing up your information

You should create your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably current
backup. Your initial and subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.
Note the following when backing up:

e  Store personal files in the Documents library, and back it up regularly.

e  Back up templates that are stored in their associated directories.

e  Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your
settings. The screen shot can be a time-saver if you have to reset your preferences.

e  When backing up to discs, number each disc after removing it from the drive.

224y,

Ef NOTE: For detailed instructions on various backup and restore options, perform a search for these topics in
Help and Support. To access Help and Support, select Start > Help and Support.

[%’/]f’ NOTE: You may be prompted by User Account Control for your permission or password when you perform
certain tasks. To continue a task, select the appropriate option. For information about User Account Control,
see Help and Support: Select Start > Help and Support.

To create a backup using Windows Backup and Restore:

[%/'”r NOTE: The backup process may take over an hour, depending on file size and the speed of the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup.

System Restore

If you have a problem that might be due to software that you installed on your computer, or if you want to
restore the system to a previous state without losing any personal information, use System Restore to return
the computer to a previous restore point.

[%/'”r NOTE: Always use this System Restore procedure before you use the System Recovery feature.

To start System Restore:
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1. Close all open programs.
2.  Click the Start button, right-click Computer, and then click Properties.

3. Click System protection, System Restore, click Next, and then follow the on-screen instructions.

System Recovery

A WARNING! This procedure will delete all user information. To prevent loss of information, be sure to back up
all user information so you can restore it after recovery.

System Recovery completely erases and reformats the hard disk drive, deleting all data files that you have
created, and then reinstalls the operating system, programs, and drivers. However, you must reinstall any
software that was not installed on the computer at the factory. This includes software that came on media
included in the computer accessory box, and any software programs you installed after purchase. Any
personal files must be restored from backups you made.

If you were not able to create system recovery DVDs or USB flash drive, you can order a recovery disc set from
support. Go to http://www.hp.com/support, select your country or region, and follow the on-screen
instructions.

[%”r NOTE: Always use the System Restore procedure before you use the System Recovery program. See System
Restore on page 114.

You must choose one of the following methods to perform a System Recovery:

e  Recovery image — Run System Recovery from a recovery image stored on your hard disk drive. The
recovery image is a file that contains a copy of the original factory-shipped software. To perform a
System Recovery from a recovery image, see System Recovery when Windows is responding
on page 115 or System Recovery when Windows is not responding on page 116.

e  Recovery media — Run System Recovery from recovery media that you have created from files stored
on your hard disk drive or purchased separately. See System Recovery using recovery media (select
models only) on page 116.

System Recovery when Windows is responding

A CAUTION: System Recovery deletes all data and programs you created or installed. Before you begin, back
up any important data to a CD or DVD or to a USB flash drive.

[:;’/r NOTE: Insome cases, you must use recovery media for this procedure. If you have not already created this
media, follow the instructions in Creating recovery media on page 112.

If the computer is working and Windows 7 is responding, use these steps to perform a System Recovery:
1. Turn off the computer.
2. Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.
3. Turnon the computer.
4. When Windows has loaded, click the Start button, and then click All Programs.
e [f Security and Protection is listed, continue with step 5.

e [f Productivity and Tools is listed, follow the steps in System Recovery when Windows is not
responding on page 116.

5. Click Security and Protection, click Recovery Manager, and then click Recovery Manager. If prompted,
click Yes to allow the program to continue.
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10.

Under I need help immediately, click System Recovery.
Select Yes, and then click Next. Your computer restarts.

When the computer restarts, you will see the Recovery Manager welcome screen again. Under | need
help immediately, click System Recovery. If you are prompted to back up your files, and you have not
done so, select Back up your files first (recommended), and then click Next. Otherwise, select Recover
without backing up your files, and then click Next.

System Recovery begins. After System Recovery is complete, click Finish to restart the computer.

When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then turn the
computer back on.

System Recovery when Windows is not responding

A CAUTION: System Recovery deletes all data and programs you created or installed.

If Windows is not responding, but the computer is working, follow these steps to perform a System Recovery.

1.

2
3.
4

v

Turn off the computer. If necessary, press and hold the power button until the computer turns off.
Disconnect all peripheral devices from the computer, except the monitor, keyboard, and mouse.
Press the power button to turn on the computer.

As soon as you see the HP logo screen, repeatedly press the F11 key on your keyboard until the Windows
is Loading Files... message appears on the screen.

At the HP Recovery Manager screen, follow the on-screen instructions to continue.

When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then turn the
computer back on.

System Recovery using recovery media (select models only)

Use the steps provided in this section if you created recovery media using Creating recovery media using HP
Recovery Manager (select models only) on page 112. If you used HP Recovery Disc Creator to create a

Windows 7 operating system DVD and a Driver Recovery DVD, use the steps in Using HP Recovery Disc
operating system discs (select models only) on page 117.

A CAUTION: System Recovery deletes all data and programs you have created or installed. Back up any
important data to a CD or DVD or to a USB flash drive.

To perform a System Recovery using recovery media:

1.

If you are using a set of DVDs, insert the first recovery disc into the DVD drive tray, and close the tray. If
you are using a recovery USB flash drive, insert it into a USB port.

Click the Start button, and then click Shut Down.
or

If the computer is not responding, press and hold the power button for approximately 5 seconds or until
the computer turns off.

Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

Press the power button to turn on the computer, and press Esc as the computer is powering on to
display the startup menu.

Use the arrow keys to select the boot menu, and press Enter. Use the arrow keys to select the location
where the recovery media is inserted (USB or DVD). Press Enter to boot from that device.
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6. If Recovery Manager asks if you want to run System Recovery from Media or Hard Drive, select Media. On
the Welcome screen, under I need help immediately, click Factory Reset.

7. If you are prompted to back up your files, and you have not done so, select Back up your files first
(recommended), and then click Next. Otherwise, select Recover without backing up your files, and
then click Next.

8. If you are prompted to insert the next recovery disc, do so.

9. When Recovery Manager is finished, remove the recovery disc or the recovery USB flash drive from the
system.

10. Click Finish to restart the computer.

Using HP Recovery Disc operating system discs (select models only)

Use the steps provided in this section if you used HP Recovery Disc Creator to create a Windows 7 operating
system DVD and a Driver Recovery DVD. If you created recovery media using Creating recovery media using HP
Recovery Manager (select models only) on page 112. use the steps in System Recovery using recovery media
(select models only) on page 116.

If you cannot use the recovery discs you previously created using the HP Recovery Disc Creator (select models
only), you must purchase a Windows 7 operating system DVD to reboot the computer and repair the operating
system.

To order a Windows 7 operating system DVD, contact support. Go to http://www.hp.com/support, select your
country or region, and follow the on-screen instructions.

A CAUTION: Using a Windows 7 operating system DVD completely erases the hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you restore
the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:

4" NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive before
the Windows operating system loads.

’L%y NOTE: If the computer does not boot to the DVD, restart the computer and press Esc as the computer
is powering on to see the startup menu. Use the arrow keys to select the boot menu and press Enter. Use
the arrow keys to select the location where the recovery DVD is inserted. Press Enter to boot from that
device.

When prompted, press any keyboard key.
Follow the on-screen instructions.
Click Next.

Select Install now.

A

Follow the on-screen instructions.
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After the repair is completed:
1. Eject the Windows 7 operating system DVD and then insert the Driver Recovery DVD.

2. Follow the on-screen instructions to install the Hardware Enabling Drivers first, and then install
Recommended Applications.
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Battery replacement

The battery installed on the computer provides power to the real-time clock. When replacing the battery, use
a battery equivalent to the battery originally installed on the computer. The computer has a 3-volt lithium
coin cell battery installed.

A WARNING! The computer contains an internal lithium manganese dioxide battery. There is a risk of fire and
burns if the battery is not handled properly. To reduce the risk of personal injury:

Do not attempt to recharge the battery.

Do not expose to temperatures higher than 60°C (140°F).

Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.
Replace the battery only with the HP spare designated for this product.

A CAUTION: Beforereplacing the battery, it is important to back up the computer CMOS settings. When the
battery is removed or replaced, the CMOS settings will be cleared.

Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.

[’?f' NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC wall
socket. The lithium battery is only used when the computer is NOT connected to AC power.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and rechargeable
batteries. For more information about recycling programs, go to http://www.hp.com/recycle.

1. Remove/disengage any security devices that prohibit opening the computer.

2 Remove all removable media, such as compact discs or USB flash drives, from the computer.

3.  Turn off the computer properly through the operating system, then turn off any external devices.
q

Disconnect the power cord from the power outlet and disconnect any external devices.

A CAUTION: Regardless of the power-on state, voltage is always present on the system board as long as
the system is plugged into an active AC outlet. You must disconnect the power cord to avoid damage to
the internal components of the computer.

5. Remove the computer access panel.

6. Locate the battery and battery holder on the system board.

[%”r NOTE: Onsome computer models, it may be necessary to remove an internal component to gain
access to the battery.

7. Depending on the type of battery holder on the system board, complete the following instructions to
replace the battery.

Type 1
a. Lift the battery out of its holder.

119


http://www.hp.com/recycle

b. Slide the replacement battery into position, positive side up. The battery holder automatically
secures the battery in the proper position.

Type 2

a. Torelease the battery from its holder, squeeze the metal clamp that extends above one edge of
the battery. When the battery pops up, lift it out (1).

b. Toinsert the new battery, slide one edge of the replacement battery under the lip of the holder
with the positive side up. Push the other edge down until the clamp snaps over the other edge of
the battery (2).

Type3
a. Pull back on the clip (1) that is holding the battery in place, and remove the battery (2).
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[’_ﬁ/f NOTE: After the battery has been replaced, use the following steps to complete this procedure.

8.
9.

10.
11.

b. Insert the new battery and position the clip back into place.

Replace the computer access panel.
Plug in the computer and turn on power to the computer.
Reset the date and time, your passwords, and any special system setups using Computer Setup.

Lock any security devices that were disengaged when the computer access panel was removed.
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B Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch feature on
the computer permits it to operate from any line voltage between 100-120 or 220-240 volts AC. Power
supplies on those computers that do not have external power switches are equipped with internal switches
that sense the incoming voltage and automatically switch to the proper voltage.

The power cord set received with the computer meets the requirements for use in the country where you
purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country where you use the
computer.

General Requirements

The requirements listed below are applicable to all countries:

1. The power cord must be approved by an acceptable accredited agency responsible for evaluation in the
country where the power cord set will be installed.

2. The power cord set must have a minimum current capacity of 10A (7A Japan only) and a nominal voltage
rating of 125 or 250 volts AC, as required by each country’s power system.

3. The diameter of the wire must be a minimum of 0.75 mm, or 18AWG, and the length of the cord must be
between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed uponiit or
against it. Particular attention should be paid to the plug, electrical outlet, and the point where the cord exits
from the product.

A WARNING! Do not operate this product with a damaged power cord set. If the power cord set is damaged in
any manner, replace it immediately.

Japanese Power Cord Requirements

For use in Japan, use only the power cord received with this product.

A CAUTION: Do not use the power cord received with this product on any other products.
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Country-Specific Requirements

Additional requirements specific to a country are shown in parentheses and explained below.

Country Accrediting Agency Country Accrediting Agency
Australia (1) EANSW Italy (1) IMQ

Austria (1) OVE Japan (3) METI

Belgium (1) CEBC Norway (1) NEMKO

Canada (2) CSA Sweden (1) SEMKO

Denmark (1) DEMKO Switzerland (1) SEV

Finland (1) SETI United Kingdom (1) BSI

France (1) UTE United States (2) uL

Germany (1) VDE

1.  The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm, conductor size. Power cord set fittings (appliance coupler and
wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it will be used.

2. The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type
with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3. Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese
Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm, conductor size. Wall plug must be a two-pole
grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.
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C Statement of Volatility

HP confirms that AMD-based business desktop HP EliteDesk 705 G3 Microtower and Small Form Factor
systems contain DDR4 volatile memory (memory amount depends on the customer configuration). In
addition, the motherboard in the condition originally shipped without subsequent modification or the addition
or installation of any applications, features, or functionality, contain the following nonvolatile memory: Real
Time Clock battery backed-up configuration memory (256 Bytes), DIMM Serial Presence Detect (SPD)
configuration data (256 Bytes per module, 128 Bytes programmable), Serial Peripheral Interface (SPI) ROM
for System BIOS (8M Bytes) and Super 1/0’s: masked keyboard ROM (overall 2K Bytes). In addition, these units
contain a Trusted Platform Module (TPM) that contains 16K Bytes of non-volatile memory for user data. The
volatile memory will not hold any user data once power has been removed for 30 seconds or longer.

The following procedure shows the steps that should be taken to restore the Non-Volatile memory:
1. Download the latest BIOS (system ROM) from the HP website.
2. Follow the instructions to flash the BIOS that are found on the website.

Flashing the BIOS will reset it back to factory settings.

3. Turnon the system, and while system is powering on, and after the HP splash screen, press the F10 key
to enter BIOS setup screen.

4. Select Security > System Security from the main menu. If the Embedded Security Device Support
option is set to “Disable”, skip to step 7.

5. To erase all security keys from the TPM:

Under Embedded Security Device in the System Security menu, configure Reset to Factory Settings to
Reset.

[1?? NOTE: Although the TPM security keys will be cleared, data in the non-volatile memory indices may
not be. Data stored in these indices should not contain security sensitive information. If an application
locks down and secures the non-volatile indices, these indices cannot be cleared.

6. Press F10 to accept changes.
7. To clear the secure boot key database:
a. Enter the F10 setup utility.
b. Go to the Security menu.
¢. Select Secure Boot Configuration.
d. Inthe Key Management section, select clear Secure boot keys.
e. Usespace key to select clear.
f.  Pressthe F10 key to accept changes.
g. From the main menu select File > Save Changes and Exit.
8. If the Ownership Tag or Asset Tag is set, manually clear it under Security > System Ids.
9. Select File > Save Changes and Exit.

10. To clear the Setup or Power-0n passwords if set, and clear any other settings, power down the computer
and remove the AC power cord and the computer hood.
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11. Locate the green two pin password jumper on header E49 (labeled PSWD) and remove it.

12. Remove the AC power, wait 10 seconds until the unit AC power has drained out, then press the clear
CMOS button. This is typically a yellow push button (labeled CMQS).

13. Replace the hood and AC power cord and turn the computer on. The passwords are now cleared and all
other user-configurable, non-volatile memory settings are reset to their factory default values.

14. Enter the F10 setup utility.

15. Select File > Default Setup > Restore Factory Settings as Default. This will set the default settings
back to the factory defaults.

16. Select File > Apply Defaults and Exit.

17. Shut down the computer, remove the AC power cord and place the (blue/green) jumper back on header
E49. Replace the computer hood and power cord.

If Computrace is enabled on the computer, see the service provider for instruction to disable the feature.
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D Specifications

MT Specifications

Table D-1 Specifications

u.s. Metric
Chassis
Height 14.0in 355mm
Width 6.7in 170 mm
Depth 13.4in 340 mm
Approximate Weight 1491b 6.76 kg
Temperature Range
Operating 50° to 95°F 10° to 35°C
-22°to 140°F -30° to 60°C

Nonoperating

NOTE: Operating temperature is derated 1.0° C per 300 m (1000 ft) to 3000 m (10,000 ft) above sea level; no direct
sustained sunlight. Maximum rate of change is 10° C/Hr. The upper limit may be limited by the type and number of options
installed.

Relative Humidity (noncondensing)

Operating 10-90% 10-90%
Nonoperating (38.7°C max wet bulb) 5-95% 5-95%
Maximum Altitude (unpressurized)

Operating 10,000 ft 3048 m
Nonoperating 30,000 ft 9144 m
Power Supply

Operating Voltage Range 90-264 VAC

Rated Voltage Range' 100-240 VAC

Rated Line Frequency 50-60 Hz

Operating Line Frequency 47-63 Hz

Standard Efficiency 280W active PFC

80 PLUS Bronze 280W active PFC

280W active PFC; 82/85/82% efficient at 20/50/100%
load (115V)

280W active PFC; 82/85/82% efficient at 20/50/100%
load (230V)

80 PLUS Platinum
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Table D-1 Specifications (continued)

u.s. Metric
280W active PFC; 91/93/90% efficient at 20/50/100%
load (230V)

The 280W power supply meets the 5000m requirements of CCC.

Rated Input Current 3.6A

Current Leakage (NFPA 99)

With ground <100 pA

Without ground <275pA

1 This system utilizes an active power factor corrected power supply. This allows the system to pass the CE mark requirements for use
in the countries of the European Union. The active power factor corrected power supply also has the added benefit of not requiring an
input voltage range select switch.
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